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About this book

This book explains how to plan and prepare for installation of IBM®
WebSphere® Message Broker for Multiplatforms Version 6.0 and IBM
WebSphere Message Broker for z/OS® Version 6.0.

This edition of the book is specific to components at the following levels, and
to all subsequent releases and modifications unless otherwise indicated in new
editions:

* Runtime components Version 6.0.0.1
* Message Broker Toolkit Version 6.0.0.1

WebSphere Message Broker for Multiplatforms and WebSphere Message
Broker for z/OS are supported on the following operating systems:
* Multiplatforms:

- IBM AIX®

- HP-UX (PA-RISC platform)

— Linux® (POWER"" platform) for iSeries " and pSeries®

— Linux (x86 platform)

— Linux (zSeries® platform)

— Sun Solaris Operating Environment (SPARC platform)

— Sun Solaris Operating Environment (x86-64 platform)

— Microsoft® Windows® XP and Windows 2003
+ IBM z/0S

The book describes tasks that you must complete before and after you install
this product. For WebSphere Message Broker for Multiplatforms, it gives
details of how to install both an initial installation, and an upgrade to an
existing installation; for WebSphere Message Broker for z/OS, see the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter Extension for z/OS for
equivalent information.

Finally, this book tells you how to verify that your installation, on systems on
which you have installed all components, has been successful, and how to
find further information about the product.

The book is divided into four parts:

* [Part 1, “Planning,” on page 1

* [Part 2, “Preparation,” on page 45|

* [Part 3, “Installation,” on page 73|

o [Part 4, “After installation,” on page 105|

© Copyright IBM Corp. 2005,2006 ix



About this book

Appendixes provide further support and reference information.

If you have ordered WebSphere Message Broker with Rules and Formatter
Extension for Multiplatforms, use this book to install WebSphere Message
Broker, then insert the appropriate Rules and Formatter Extension CD for
your operating system. The Design-time Extension CDs provide extensions to
the toolkit, the Run-time Extension CDs provide extensions to the broker
runtime components.

If you have ordered WebSphere Message Broker with Rules and Formatter
Extension for z/OS, use the Program Directory for WebSphere Message Broker
with Rules and Formatter Extension for z/OS to install both broker and broker
runtime component extensions.

For further information specific to the Rules and Formatter Extension, see the
documentation on the supplied Rules and Formatter Extension CD, or access
the V6.0\Rules and Formatter directory on the [documentation FTP site| at:

ftp://ftp.software.ibm.com/software/integration/wbibrokers/docs

This book does not provide details about how to install optional software or
remove the product. See the information center for instructions on those tasks.
You can access the information center from the product after you have
installed the Message Broker Toolkit, or you can access it from other locations
before installation. See [“Where to find more information” on page xii| for
details of the options available.

Who this book is for

This book is for system administrators of systems on which WebSphere
Message Broker components are installed.

What you need to know to understand this book

To understand this book, you must be familiar with the system facilities of
your operating system, for example accessing CDs and setting up security.

Terms used in this book

All references in this book to Windows are applicable to Windows XP and
Windows 2003 unless otherwise stated.

The term Linux refers to Linux (POWER platform), Linux (x86 platform), and
Linux (zSeries platform) where their behavior is common.

X Installation Guide
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Terms used in this book

The term Solaris refers to Solaris (SPARC platform with Solaris 8, Solaris 9, or
Solaris 10) and Solaris (x86-64 platform with Solaris 10) where their behavior
is common.

The term UNIX® refers to the operating systems AIX, HP-UX, and Solaris
where their behavior is common.

The term distributed system refers to Windows, Linux, and UNIX systems
where their behavior is common.

The term installer refers to the installation wizard (its name is not the same on
every operating system).

The term install_dir refers to the directory in which you install the product.

The term working directory refers to a directory on a distributed system that is
associated with the current user logon ID. It contains product-related files.

DB2® Enterprise Server refers to IBM DB2 Universal Database " Enterprise
Server Edition. A copy of DB2 Enterprise Server Edition Version 8.2 with
tailored terms and conditions is supplied with WebSphere Message Broker for
Multiplatforms. On z/OS, DB2 Enterprise Server is a prerequisite product.
Other editions of DB2 Universal Database (Multiplatforms and z/OS) that are
stated to be suitable for production deployment are also supported (for
example, Workgroup Server Edition).

Derby refers to IBM Cloudscape " Version 10.0, a database product that is
built on the Derby database from the Apache Software Foundation.
Cloudscape does not modify Derby in any way, but provides additional
function including installers. Derby database support is embedded in the
broker component on Windows only. See [“Databases” on page 9| for further
information about Derby:.

The Message Broker Toolkit refers to the installable component that provides a
graphical interface for administration, configuration, and development for
WebSphere Message Broker. After installation, this component is referred to by
its generic name, the Message Brokers Toolkit. Both terms, Message Broker
Toolkit and Message Brokers Toolkit, are used in this book, depending on the
context of the reference (before or after installation).

Key terms introduced in this book are defined in the [‘Glossary of terms and]
labbreviations” on page 149) For a full product glossary, see the information
center.

About this book X1



Terms used in this book

For information about terms and abbreviations that are not specific to this
product, see the [[BM Terminology Web site at

http://www.ibm.com/software/globalization/terminology/

Where to find more information

xii

This book contains only installation information. Most of the information that
you need to use this product is contained in the information center, which
you can access from the Help > Help Contents menu in the Message Brokers
Toolkit after installation.

You can access the information center before and after installation from these
additional locations:

The documentation CD that is included in the product package.

The information center is provided for Linux (x86 platform) and Windows,
and you can start it in both stand-alone mode (access is limited to the local
computer) or web server mode (which supports local and remote access).
You can access the information center directly on CD, or you can copy the
files onto disk. Instructions are provided in the
installing_and_managing.htm file on the CD.

The [documentation FTP site] at:
ftp://ftp.software.ibm.com/software/integration/wbibrokers/docs

Download file wmb_help_Tlin.zip for Linux (x86 platform) or

wmb_help win.zip for Windows, and follow the instructions in the
installing_and_managing.htm file that is included in each compressed file.
The downloaded information center can also be started in stand-alone
mode or web server mode.

On this site you can also find PDF files of topic collections for printing, and
translated versions of product readme files.

The online [BM WebSphere Message Brokers Information Centet] at:

http://publib.boulder.ibm.com/infocenter/wmbhelp/v6rOmo/index.jsp

The information center on the documentation CD, and that available from the
FTP site, includes documentation plug-ins for WebSphere Message Broker,
WebSphere Event Broker, WebSphere MQ Version 6.0, and WebSphere MQ
Everyplace® Version 2.0.2.0.

The latest product readme file, in US English only, is available from the

[product support| Web site at:

http://www.ibm.com/software/integration/whimessagebroker/support/

Installation Guide
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Information sources

Publications
The following books are available for WebSphere Message Broker:
* WebSphere Message Broker Installation Guide (GC34-6621) (this book)
* Program Directory for WebSphere Message Broker for z/OS (GI10-2595)
* Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS (GI10-2596)
Related products

Online information centers and publications for other IBM products that you
might use with WebSphere Message Broker are available through the
[Publications Center] at:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi

Direct links are provided below.

WebSphere MQ
The WebSphere MQ documentation is included in the integrated
information center provided on the WebSphere Documentation CD.

You can also access the WebSphere MQ information center at:
http://publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp

DB2 Enterprise Server
Access the information center at:
http://publib.boulder.ibm.com/infocenter/db2help/index.jsp
DB2 Run-Time Client

Access the information center at:
http://publib.boulder.ibm.com/infocenter/cldscpl0/index.jsp

WebSphere MQ Everyplace
The WebSphere MQ Everyplace documentation is included in the
integrated information center provided on the WebSphere
Documentation CD.

Rational Agent Controller
The Rational® Agent Controller documentation is provided on the
supplemental CD that contains the code for this product.
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Information sources

WebSphere information on the Web

Follow links on the [WebSphere Web site]at http://www.ibm.com/software/
infol/websphere to:

* Obtain the latest information about WebSphere products

* Access manuals, white papers, IBM Redbooks™, and other information
sources

+ Download service and support information including SupportPac™
offerings

* Access information about IBM Business Partners and associated offerings
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Summary of changes

This section describes changes in this edition of WebSphere Message Broker
Installation Guide. Changes since the previous edition of the book are marked
by vertical lines to the left of the changes.

Changes for this edition

* Support is added for the following platforms:
— Linux (POWER platform) for iSeries and pSeries
— Solaris (x86-64 platform)

* Support is added for the following operating systems:
— Linux Red Hat Enterprise Advanced Server V4 (Intel (32-bit) and zSeries
(31-bit))
— Solaris 10
* Support is added for the following databases:
— Microsoft SQL Server 2000 accessed from Linux and UNIX platforms
— Informix Dynamic Server V9.4

* Information has been modified to reflect that runtime components have
been updated to version 6.0.0.1.

* Minor technical corrections and editorial changes have been made
throughout the book.

Changes for the second edition (GC34-6621-01)

* Information that concerns the Message Broker Toolkit has been updated to
reflect its new version, 6.0.0.1. Instructions for installing on new systems,
and for upgrading a current Version 6.0.0.0 installation are provided.

¢ Installation instructions for systems that have multiple Rational products
installed have been updated.

* Minor technical corrections and editorial changes have been made
throughout the book.

© Copyright IBM Corp. 2005,2006 XV
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Part 1. Planning

The first part of this book describes the environment that you need before you
can install WebSphere Message Broker. The information here addresses z/OS
and distributed systems.

* [Chapter 1, “System requirements,” on page 3|

* [Chapter 2, “Coexistence and migration,” on page 23

* [Chapter 3, “National language support,” on page 31|

* [Chapter 4, “Installation packages,” on page 35

© Copyright IBM Corp. 2005,2006 1
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Chapter 1. System requirements

Before you install WebSphere Message Broker, you must check that your
system meets both the hardware and software requirements of the product.
Details are provided in these sections:

* [‘Hardware requirements” on page 4|

* [’Software requirements” on page 8§

The product readme file readme.html might contain updates to the
information in this chapter. Always check for later information in the readme
file, which is available from these locations:

* Before installation, on the product media. The same file is included on DVD
(on Linux (x86 platform) and Windows only), runtime components Disk 1
(all operating systems), runtime components Disk 2 and Disk 3 (Windows
only), and on Message Broker Toolkit Disk 1 in location \readmes\locale\,
where locale identifies country, region, or language, for example en_US.

» After installation, in install_dir\readmes\locale\.

The file is updated occasionally; access the [product support| Web site to check
that you have the latest level. Access the Web site at:

http://www.ibm.com/software/integration/whimessagebroker/support/

For information about license requirements, see |”License requirements” 0n|
page 21.

The information in this chapter is repeated in the information center (under
Reference > Installation), so that you can check requirements online after
installation.

© Copyright IBM Corp. 2005,2006 3
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Hardware requirements

Hardware requirements

To run this product, install the Message Broker Toolkit on at least one system.
This component can be installed only on Linux (x86 platform) and Windows,
and you must therefore include one of these systems in your environment. All
other components can be installed on all supported operating systems.

Check that your target systems are at the required level of support.
describes what you need.

Table 1. Hardware requirements

Operating system Requirements?

AIX IBM e(logo)server® pSeries
IBM RS/6000® processor machines
IBM e(logo)server i5

HP-UX Hewlett-Packard HP-9000 PA-RISC 2.0 processor machines?
Linux (POWER IBM e(logo)server iSeries
platforms) IBM e(logo)server pSeries
Linux (x86 platform) |IBM e(logo)server xSeries® or equivalent Intel® based systems?
Linux (zSeries IBM e(logo)server zSeries 600 or e(logo)server 700 Server
platform)
Solaris (SPARC Sun Microsystems SPARC processor machines
platform)
Solaris (x86-64 Sun Microsystems AMD64 or equivalent EM64T based systems
platform)
Windows IBM e(logo)server xSeries or equivalent Intel based systems
IBM e(logo)server iSeries Server using the IBM Integrated xSeries Server#
z/08S? Any server capable of running one of the supported z/OS releases
Notes:

1. Always check the readme.html file for the latest information about
supported hardware.

2. The +DAportable flag cannot be used for 64-bit compilations, therefore
PA-RISC 1.1 chips are no longer supported.

3. The Message Broker Toolkit requires any Intel Pentium® III (or higher)
processor-based IBM PC or compatible, with 700 or more MHz processor
speed. This specification is the minimum supported level; for improved
performance, use a 2 GHz processor.

A minimum display resolution of at least 1024 x 768 is required for some
dialog boxes (for example, the Preferences dialog box).

4. You must install OS/400® Version 5 Release 2 or Version 5 Release 3 on
the iSeries Server to exploit this support.
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Hardware requirements

5. See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details.

DVDs are provided for Linux (x86 platform) and Windows; if you want to
install from DVD your system must have a DVD reader. All other systems
require a CD reader. For details of the CDs and DVDs supplied, see
[“Installation packages,” on page 35|

Memory and disk space

WebSphere Message Broker memory and disk space requirements depend on
the installation operating system, and the components that you are installing.

Distributed systems

* 512 MB of RAM are required to support runtime operations (1 MB
equals approximately 1 000 000 bytes).

* 512 MB of RAM are required to support Message Broker Toolkit
operations on Linux (x86 platform) or Windows. This specification
is the minimum supported level; for improved performance,
provide 1 GB (1 GB equals approximately 1 000 000 000 bytes).

* Disk space requirements are dependent on the components that you
install and the working space that is required by those components
(for example, for WebSphere MQ queues and persistent messages).

Check that your system has at least the space shown in
which provides guidance for both permanent product

requirements and temporary space. If you install just one or two of
the runtime components, the storage required is reduced by only a
small amount. Check that these requirements have not been
updated in the latest product readme file readme.html (the location
of this file is described at the beginning of this chapter).

If the installation directory and the temporary space are on the
same partition or drive, add together the two figures to check that
you have enough space available. If you do not, increase the
available storage or change either the location of the temporary
space or the installation directory. The temporary files are deleted
when installation has completed.

- On AIX, HP-UX, and Linux systems, the default temporary space
directory is /tmp.

— On Solaris systems, the default temporary space directory is
/var/tmp.

— On Windows, the default temporary space directory is pointed to
by the TEMP system variable. On some systems, the variable
TMP exists and is used before TEMP, so you might need to check
or change the setting of both these variables.

Chapter 1. System requirements 5



Memory and disk space

If you are installing the Message Broker Toolkit, you can specify a
different temporary space directory when you invoke the
installation wizard, as described in [“Changing the location of the|

[temporary space directory” on page 102)

The installation wizard displays requirements for permanent space,
but not for temporary space. If the figure that the installation
wizard displays is greater than the figure shown in check
that your system has sufficient space before you continue with the
installation.

Table 2. Disk space requirements

Component AIX HP-UX Linux?!+*2 Solaris Windows?
Broker, 500 MB 680 MB 300 MB 550 MB 310 MB
Configuration plus 300 MB | plus 300 MB |plus 300 MB |plus 300 MB |plus 300 MB
Manager, and User | temporary temporary temporary temporary temporary
Name Server space space space space space
Transformation 45 MB 50 MB 25 MB 30 MB 30 MB
Services (optional
broker extension)
Message Broker Not available |Not available [5.0 GB Not available |5.0 GB
Toolkit plus 1.9 GB plus 1.9 GB
temporary temporary
space space

6 Installation Guide

Notes:

1. Requirements vary slightly on different Linux offerings;
maximum figures are shown.

2. The Message Broker Toolkit is available on Linux (x86 platform)

and Windows only.

* If you install one of the database products supplied with

WebSphere Message Broker, you need additional disk space:

— DB2 Enterprise Server requires approximately 300 MB. This
specification is for a Compact installation, which provides
sufficient function for WebSphere Message Broker; if you choose
a Typical or Custom installation, additional storage might be
required (see|“Databases” on page 9).

— On Windows, ODBC (Open Database Connectivity) drivers for
Cloudscape require approximately 105 MB.




Memory and disk space

* On systems on which you create a broker, approximately 10 MB is
required for the broker tables. If you create databases to store data
that is accessed during message processing, additional space is
required on those systems.

z/OS  See the section about DASD storage requirements in the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory
for WebSphere Message Broker with Rules and Formatter Extension for
z/OS.

Communications

Check that your system has communications hardware that supports at least
one of the following protocols:

* NetBIOS

* SNA LU 6.2

« SPX

« TCP/IP

Chapter 1. System requirements 7



Software requirements

Software requirements

WebSphere Message Broker has specific requirements for operating system
software, and for supporting products. Details are provided in these sections:

‘Operating system requirements”|
‘Databases” on page 9|

‘Additional required products” on page 15|
‘Optional software” on page 19|

Operating system requirements

Ensure that you have the correct level of operating system software before
you install WebSphere Message Broker. Check the requirements for your

operating system in [Table 3

Table 3. Operating system requirements

Operating Requirements?
system
AIX * AIX V5.2 with Maintenance Level 3

* AIX V5.3 with Maintenance Level 2
HP-UX » HP-UX 11i V1 (B.11.11) (plus December 2003 QPK)
Linux (POWER |+ Linux PowerPC Red Hat Enterprise Advanced Server V4 (plus Update 2) (Kernel
platform) Version 2.6)

* Linux PowerPC SUSE Linux Enterprise Server (SLES) 9 (Kernel Version 2.6)
Linux (x86 * Linux Intel (32-bit) Red Hat Enterprise Advanced Server V3.0 (plus Update 2)
platform)2+3 (Kernel Version 2.4.21)

Linux Intel (32-bit) Red Hat Enterprise Advanced Server V4.0 (plus Update 2)
(Kernel Version 2.6)
Linux Intel (32-bit) SUSE Linux Enterprise Server (SLES) 9 (Kernel Version 2.6 )

Linux (zSeries
platform)

Linux zSeries (31-bit) Red Hat Enterprise Linux Advanced Server V3.0 (plus Update
2) (Kernel Version 2.4.21)

Linux zSeries (31-bit) Red Hat Enterprise Advanced Server V4.0 (plus Update 2)
(Kernel Version 2.6)

Linux zSeries (31-bit) SUSE Linux Enterprise Server (SLES) 9 (Kernel Version 2.6)

Solaris (SPARC
platform)

Solaris 8 (plus SunSolve recommended Patch Cluster level and Patch ID 111308-05)4
Solaris 9 (plus SunSolve recommended Patch Cluster level)
Solaris 10 (plus SunSolve recommended Patch Cluster level)

Solaris (x86-64

Solaris 10 (plus SunSolve recommended Patch Cluster level)

platform)
Windows * Windows XP Professional
* Windows Server 2003 Standard Edition
* Windows Server 2003 Enterprise Edition
z/0S5 e z/0OS V1.5 or later
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Operating system requirements

Notes:

1. Always check the readme.html file for the latest information about
supported software.

2. The Message Broker Toolkit is supported on Linux Intel (32-bit) Red Hat
Enterprise Linux Advanced Server V3.0 and Linux Intel (32-bit) SUSE
LINUX Enterprise Server (SLES) 9 only.

3. You might require the following additional packages on Linux (x86
platform). These are available with the operating system.

* If you choose to install in graphical mode, compatibility libraries are
required:

— Red Hat Enterprise Advanced Server V3.0: package compat-Tibstdc++

— SUSE Linux Enterprise Server: package compat (at version 2002.12.6.0
or later)

These are not required for console or silent installations.

* If you want to use the package monitor (RPM), the rpm-build package
is required.

4. This patch provides multithreaded malloc support on Solaris 8. It is
required because the standard system malloc library is optimized for
single threaded applications, but the broker typically runs many threads
and requires the multithreaded mtmalloc.

5. See the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS for further details. In particular, review the information
in "Preventative Service Planning”.

Databases

A broker requires a database to contain operational and state data. You can
complete the WebSphere Message Broker installation program if you do not
have a suitable database installed on this system, but you must install one
before you create a broker. (If you use the Launchpad when you install on
Windows, you can select a suitable database to be installed by the Launchpad
at that time. See [Chapter 8, “Installing with the Windows Launchpad,” on|

for details.)

DB2 Enterprise Server is supplied with WebSphere Message Broker for
Multiplatforms. You can install and use DB2 Enterprise Server on all
supported operating systems. A Compact installation provides all the function
that is required by WebSphere Message Broker; Typical and Custom
installations are also available and the installation program provides further
details about additional features and storage requirements.

On z/0S, you must obtain your own copy of DB2 Enterprise Server. If you do
not already have DB2 installed, contact your IBM representative for further
information and assistance.
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On Windows only, you can use the embedded Derby database, which is
supported for test and evaluation purposes only. No other Cloudscape or
Derby database is supported; you can use only the database embedded in the
broker component.

To use Derby, you do not have to install any database server code, but you
must install the ODBC Drivers for Cloudscape that provide an interface to
that database. These are available with the IBM DB2 Run-Time Client for
Windows Version 8.2, a copy of which is provided on CD or DVD for
WebSphere Message Broker for Multiplatforms on Windows only. If you
install using the Windows Launchpad, select the option for the ODBC Drivers
for Cloudscape. If you do not use the Launchpad, install the DB2 Run-Time
Client directly from CD or DVD.

For a production system, install and configure your chosen enterprise
database, for example DB2 Enterprise Server.

Microsoft SQL Server, Oracle, and Sybase Adaptive Server Enterprise (ASE)
databases are also supported, as shown in [Table 4 on page 11} You must
acquire your own version of these products; they are not supplied with
WebSphere Message Broker.

Multiple brokers in the same installation can access the same database, if
appropriate, because all tables are qualified by the broker name. Brokers in
different installation locations on the same system cannot share a database.

You can configure message flows to access databases that hold data associated
with your message processing. The databases supported for this purpose
(known as user databases) are those supported for a broker database, with the
addition of DB2 on OS/400 and Informix® on most operating systems, as
shown in [Table 4 on page 11}

You can exploit stored procedure support on all supported databases except
Informix.

[Table 4 on page 11|shows the levels of database that are supported on each
operating system. In most situations, the broker that accesses the database
does not have to be running on the same operating system as the database
server. For details about local and remote database use, and existing
restrictions, see [‘Database locations” on page 13/
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Table 4. Supported databases

Databases

Operating system | DB2! | SQL Server | Oracle! Sybase Informix?
AIX 8.23 2000 SP3a* |9i Rel 2 Patch Set 4 |125 Dynamic Server V9.4
(9.2.0.5, patch with UC7 fix pack
3501955)
Client SDK V2.90
10G with UC4 fix pack
HP-UX 823 |2000 SP3a* |9i Rel 2 Patch Set 4 |12.5 Dynamic Server V9.4
(9.2.0.5, patch 3501955) with UC7 fix pack
10G Client SDK V2.90
with UC4 fix pack
Linux (POWER 8.23 | Not Not supported Not Not supported
platform) applicable supported
Linux (x86 8.23 |2000 SP3a* |9i Rel 2 Patch Set 4 |12.5 Dynamic Server V9.4
platform) (9.2.0.5, patch 3501955) with UC7 fix pack
10G Client SDK V2.90
with UC4 fix pack
Linux (zSeries 823 | Not Not supported Not Not supported
platform) applicable supported
0S/400% 8.2 Not Not applicable Not Not applicable
applicable applicable
Solaris (SPARC 8.23+6 12000 SP3a4 |9i Rel 2 Patch Set 4 |12.5 Dynamic Server V9.4
platform) (9.2.0.5, patch 3501955) with UC7 fix pack
10G Client SDK V2.90
with UC4 fix pack
Solaris (x86-64 8.23+6 | Not Not supported Not Not supported
platform) applicable supported
Windows 8.23+7 12000 SP3a |9i Rel 2 Patch Set 4 |12.5 Dynamic Server V9.4
(9.2.0.5, patch 3501955) with UC7 fix pack
10G Client SDK V2.90
with UC4 fix pack
z/0S 7.18 | Not Not supported Not Not supported
8.18  |applicable applicable
Notes:

1. Supported releases of DB2 and Oracle can participate as a Resource
Manager in a distributed XA transaction, and can be coordinated by
WebSphere MQ as the XA Transaction Manager. In WebSphere Message
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Broker, this support is referred to as a globally coordinated message flow.
On z/0S, all transactions are coordinated by Recoverable Resource
Services (RRS).

XA coordination for messages in the MRM domain on Windows requires
DB2 Version 8.2 FixPak 10 or later.

If you use WebSphere MQ Version 6.0 as a transaction manager, all
datasources connected to DB2 from message flows in both 32-bit and
64-bit execution groups must connect to 64-bit DB2 instances.

If you deploy message flows that access databases, you can define the
message flows to be coordinated so that updates to those databases are
synchronized with updates to other resources.

Informix is supported only as a user database that is accessed by message
flows. The client SDK only is required on each broker system; install the
Dynamic Server only on the system on which you create databases. You
cannot create a broker database as an Informix database; this option is not
supported. There is no XA and no Large Object (LOB) support.

Check the readme.html file for your product to check if a fix pack or other
fix is required.

DB2 Version 8.2 is functionally equivalent to Version 8.1 FixPak 7. If you
install DB2 Version 8.2 from the supplied CDs or DVD, you might see
information that indicates the Version 8.1 level, for example when you use
the command db2level.

SQL Server is supported only as a remote database on Windows from a
Linux or UNIX system using a supplied wire protocol driver.

You can access a DB2 database installed on OS/400 as a user database
from a message flow running on a broker on any supported system. You
cannot create a broker database on any system as a remote DB2 database
on OS/400. For further details of these restrictions, and for information
about the PTFs that are required with this product, see

ocations” on page 13.
pag
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Solaris 10 on Solaris (SPARC platform) requires DB2 Version 8.2 FixPak 9
and Solaris (x86-64 platform) requires DB2 Version 8.2 FixPak 11.

You can use the embedded Derby database for verification, evaluation, and
test purposes only. For a production system, install and configure your
chosen enterprise database.

On z/0S, DB2 is a mandatory requirement. You must create a unique
database for each broker. See the Program Directory for WebSphere Message
Broker for z/OS or the Program Directory for WebSphere Message Broker with
Rules and Formatter Extension for z/OS for further details.



Databases

Database locations
You can create and configure databases that you use with WebSphere Message
Broker on the local system, or on a remote system, subject to the following

restrictions:

* You can use a local or remote database for the broker, with the exception
that a remote database cannot be accessed on z/0OS or OS/400.

* You can use a local or remote database for user data, subject to the
following operating system restrictions:

DB2 database on iSeries

Database support on iSeries (OS/400) is DB2 only.
Your OS/400 installation must be V5R2 or V5R3.

On Linux, UNIX, and Windows you can connect using DB2
Connect™". On Windows only you can also use iSeries Access for
Windows.

Globally coordinated (XA) transactions are not supported.

New Era of Network nodes within message flows cannot access
an iSeries database.

You can call stored procedures only if access to the remote
database is provided by DB2 Connect.

DB2 database on z/Series

Database support on zSeries (z/OS) is DB2 only.
You must use DB2 Connect on Linux, UNIX, and Windows.

Large database objects (LOBs) are supported by DB2 Universal
Database for z/OS V7.1 or later.

New Era of Network nodes within message flows cannot access
a zSeries database.

See the Program Directory for WebSphere Message Broker for z/OS or
the Program Directory for WebSphere Message Broker with Rules and
Formatter Extension for z/OS for further details.

WebSphere Information Integrator support

Message flows on all distributed systems brokers can access
databases on WebSphere Information Integrator for Linux, UNIX,
and Windows Version 8.2.

Message flows on z/OS can access WebSphere Information
Integrator Classic Federation for z/OS Version 8.2. This support
provides direct SQL connectivity with the following z/OS data
sources:

- IMS™

- VSAM

- ISAM
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- Sequential files

- CA-IDMS

- CA-Datacom

- Software AG ADABAS
- DB2

WebSphere Information Integrator Classic Federation for z/OS
Version 8.2 does not support two phase commit, and you must
set up all ODBC connections with CAF (Call Attachment
Facility), not the default option which is RRSAF (Recoverable
Resource Manager Services Attachment Facility).

* If you choose to use a remote database, you must configure the ODBC
connection to the database correctly.

See the documentation for your database product to determine the best

options for your specific environment and requirements, and for information
about how to configure remote database access.
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Additional products

Additional required products

WebSphere Message Broker requires additional software products to run
successfully.

WebSphere MQ
WebSphere MQ is required for all WebSphere Message Broker components at
the minimum supported level shown in

If you do not already have WebSphere MQ, Version 6.0 (with tailored terms
and conditions for use with WebSphere Message Broker) is supplied on CD or
on DVD (on Linux (x86 platform) and Windows only).

If you have a previous version, you can use the supplied CDs or DVD to
upgrade your current installation.

Table 5. WebSphere MQ requirements

System Requirements
AIX WebSphere MQ Version 5.3.0.1 or latert+2+3
HP-UX

Solaris (SPARC platform)

Linux (POWER platform) WebSphere MQ Version 6.0.0.0 or latert+2+3

Linux (x86 platform) with Red Hat Enterprise
Advanced Server V4.0

Linux (zSeries platform) with Red Hat Enterprise
Advanced Server V4.0

Linux (x86 platform) with Red Hat Enterprise WebSphere MQ Version 5.3.0.1 or latert+2+3
Advanced Server V3.0 or
SUSE Linux Enterprise Server 9

Linux (zSeries platform) with Red Hat Enterprise
Advanced Server V3.0 or
SUSE Linux Enterprise Server 9

Solaris (x86-64 platform) WebSphere MQ Version 6.0.1.1 or later?+2

z /0S54

WebSphere MQ Version 5.3.1 with MQ Java
Classes feature2+*3

Notes:

1. The minimum set of components that you must install are the server and
Java'" Messaging components. You can install WebSphere MQ before or
after you install WebSphere Message Broker.
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If you have WebSphere MQ Version 5.3 already installed, the Java
Messaging component is not installed by default. Check that your
installation includes it; add this component from the WebSphere MQ
Version 5.3 CD if it is not installed.

If you choose to install WebSphere MQ Version 6.0 from the Windows
Launchpad, Express installation installs all required components for you. If
you use Advanced installation, you must select a custom installation and
include at least the server and Java Messaging components.

If you start the WebSphere MQ Version 6.0 installation program directly on
any operating system, including Windows, you must select a custom
installation and include at least the server and Java Messaging
components.

If you want to use the WebSphere MQ Explorer, the graphical interface
that is available on Linux (x86 platform) and Windows only, install the
WebSphere Eclipse Platform V3.0.1 and the WebSphere MQ Explorer
components.

Other components are optional for use with WebSphere Message Broker.

WebSphere Message Broker requires a full WebSphere MQ product and
cannot function correctly with the WebSphere MQ product that is included
with WebSphere Application Server Version 5 (known as Embedded
Messaging). For further clarification, see [“Optional software” on page 19]

For some specific broker functions, later levels of WebSphere MQ might be
required:

 If you are running publish/subscribe applications that use WebSphere
MQ Real-time Transport, WebSphere MQ Version 5.3.0.10 or later might
be required if you experience problems in a heavily loaded broker
system.

* If you develop message flows that include the MQOptimizedFlow node,
you must install WebSphere MQ Version 5.3.0.10 or later on each
affected broker system.

* Support for JMS SSL requires WebSphere MQ Version 5.3.0.11 or later.

* If you develop message flows that use WebSphere MQ Real-time
Transport with Multicast PGM support, you must install WebSphere MQ
Version 6.0 or later on each affected broker system. An iFix is also
required; see the readme.html file for the latest information.

* To exploit the Native POSIX Threading Library (NPTL) performance
gains on Linux systems (available with Kernel Version 2.6 and above),
which support multiple threads running within one process, you must
install WebSphere MQ Version 6.0. Performance gains might be achieved
where you have multiple message flows assigned to a single execution

group.
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4. On z/0S, WebSphere MQ is a mandatory requirement and must be
installed before you install WebSphere Message Broker. See the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter Extension for z/OS for
further details.

For details of WebSphere MQ products and supported versions, see
[WebSphere Business Integration software] at:

http://www.ibm.com/software/integration/websphere/mgplatforms/supported.html

Java Runtime Environment

The Java Runtime Environment is embedded with the product on all
operating systems except z/OS, where Java Runtime Environment (JRE)
Version 1.4.2 (Fix Pack 2) is required. For additional information, see the
fproducts for z/OS Web site| at:

http://www.ibm.com/servers/eserver/zseries/software/java/getsdkl4.html

Rational Application Developer (RAD)

The Message Broker Toolkit is based on the Rational Application Developer
(RAD) integrated development environment. RAD, which is built on a
common Rational framework, is supplied as a component of the Message
Broker Toolkit. If required, it is installed when you install the toolkit, and you
do not have to order or install RAD separately.

All Rational software products, for example RAD or Rational Software
Architect (RSA), that are installed on a single system share a single common
framework. This technique is known as shell-sharing. The first Rational
product that you install installs the common framework. When you install
further Rational products, for example the Message Broker Toolkit, the
existing framework is used and product-specific plug-ins only are installed.
Shell-sharing is enforced and cannot be deactivated.

The common framework saves space and installation time. Workbenches
associated with the installed products are integrated together so that you can
view and access all the supported functions in a single session.

Shell-sharing demands that all products that you install are based on a
compatible level of Rational. If a product you are installing is not based on a
compatible level, the installation reports that it cannot work with the existing
Rational installation, and tells you that you must upgrade the existing
installation.

The Message Broker Toolkit Version 6.0.0.1 is based on RAD Version 6.0.1.1
and is compatible with that release and later Version 6.0.1 updates. It cannot
coexist with RAD or RSA products based on Version 6.0.0 (for example 6.0.0.1)
or Version 6.0.2 and later. Other Rational products must also be at the latest
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available level. See [“Integrating with other Rational products” on page 93| for
information about how to resolve Rational incompatibilities before you install
the Message Broker Toolkit.

If you have installed the Message Broker Toolkit on Linux (x86 platform), and
you later install another Rational product, the default directory presented for
the later installation is the current installation directory for the toolkit, for
which the default location is /opt/ibm/MessageBrokersToolkit/6.0 (where 6.0
represents this version and release). Accept this default value; if you install
another Rational product into a different directory, you will not be able to
upgrade your product.

The Rational framework and RAD are not required for any of the runtime
components.

The Language Pack feature: If you work in one or more locales instead of,
or as well as, US English, you can install the Language Pack feature that is
offered with all Rational products. This feature provides additional support
for the display of messages, menus, properties, and so on in the nine locales
other than US English that are listed in [Chapter 3, “National language
lsupport,” on page 31

When you install a product based on the Rational framework, you can select
or clear an option to install the additional Language Pack feature according to
your locale requirements. If locales other than US English are detected when
you install the Message Broker Toolkit, the Language Pack feature defaults to
selected; if none are detected, it is cleared.

If you select this feature for one Rational product, you must select it for all
subsequent Rational products; if you do not, the installation fails because the
later installation does not match the features installed for the first installation.
If you have not selected it for previous Rational product installations, do not
select it when you install the Message Broker Toolkit. If you are upgrading the
Message Broker Toolkit to Version 6.0.0.1, choose the same option as you did
when you installed Version 6.0.0.0.

If you decide you require the Language Pack feature on a product after you
have installed it, for example because you want to install the Language Pack
feature on a second Rational product, you can do so; instructions are provided
in [“Adding the Language Pack feature after installation” on page 101.

Browsers

The information center is accessed from the Message Broker Toolkit on Linux
(x86 platform) and Windows. For best viewing results, use Internet Explorer
version 6.0 or higher, or Mozilla-based browsers version 1.4.2 or higher.
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Some Linux (x86 platform) offerings do not install Mozilla by default. If you
plan to install the Message Broker Toolkit on your Linux (x86 platform)
system, check that Mozilla 1.4.2 or above is already installed. If not, install
Morzilla from the operating system media.

Optional software

The products listed in this section are not required, but interact with
WebSphere Message Broker in some way that you might find useful. Two of
these products, Rational Agent Controller and WebSphere MQ Everyplace, are
supplied with WebSphere Message Broker.

None of these products are required to complete the verification procedure
described in [Chapter 11, “Configuring and verifying your system,” on page|
107,

Rational Agent Controller
Rational Agent Controller (RAC) Version 6.0.1 supports message flow
debugging. If you want to use the Debugger, you must install RAC on
each system on which you start a broker that hosts message flows.
The RAC component that you install on the broker is a server that
communicates with the RAC client which is embedded in the Message
Brokers Toolkit.

Rational Agent Controller Version 6.0.1 is supplied on a supplemental
CD, and on DVD (on Linux (x86 platform) and Windows only); see
[“Supplemental CDs” on page 42) Full instructions about how to install
the RAC server are provided in the file install.html in the root
directory of the RAC component on CD or DVD. For further
information about using RAC with WebSphere Message Broker, see
the information center.

If you have previous versions of RAC installed, consider the following

points:

* Although you can install WebSphere Message Broker Version 6.0 on
a system on which Version 5.0 is already installed, you cannot
install RAC Version 6.0 on a system on which Version 5.0 is
installed. If RAC Version 5.0 is running, stop it, and either uninstall
it or upgrade it to Version 6.0.

* If your broker domain includes WebSphere Message Broker Version
6.0 brokers and Version 5.0 brokers, do not upgrade RAC on the
Version 5.0 brokers. For details of RAC required with Version 5.0
brokers, see the information center.

* Version 2.1 brokers do not require RAC.
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WebSphere MQ Everyplace

WebSphere MQ Everyplace Version 2.0.2.0 supports mobile and
wireless applications with robust and secure messaging. Installing
WebSphere MQ Everyplace in the broker domain gives these
applications access to brokers and other services.

WebSphere MQ Everyplace Version 2.0.2.0 is supplied on a
supplemental CD and on DVD (on Linux (x86 platform) and
Windows only); see [“Supplemental CDs” on page 42| For more
information about how you can connect your WebSphere MQ
Everyplace clients with brokers, see the information center.

WebSphere Application Server

WebSphere Message Broker interacts with WebSphere Application
Server Version 5 and Version 6:

* WebSphere Message Broker requires a full WebSphere MQ product
and cannot function correctly with the WebSphere MQ product that
is included with WebSphere Application Server Version 5 (known as
Embedded Messaging).

You cannot install WebSphere MQ if you already have WebSphere
Application Server Version 5 installed, because you cannot upgrade
the Embedded Messaging component to the full WebSphere MQ
product. You must uninstall WebSphere Application Server Version
5, install WebSphere MQ), then reinstall WebSphere Application
Server Version 5.

* WebSphere Message Broker is fully compatible with WebSphere

Application Server Version 6. You do not have to take any special
action for these products to interact successfully.

Tivoli License Manager

WebSphere Message Broker includes support for IBM Tivoli® License
Manager Version 2.1. For more information about how you can
monitor the use of IBM and other product licenses with Tivoli License
Manager, see the information center.

Macromedia Flash Player
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If you want to launch the Quick Tour from the information center in
the Message Broker Toolkit, you must install Macromedia Flash Player
Version 6.0 or later. You can freely download Macromedia Flash
Player as a plug-in for a Web browser from the [Macromedia Web site|
at:

http://www.macromedia.com/software/flashplayer/

Macromedia Flash Player is not included with WebSphere Message
Broker.


http://www.macromedia.com/software/flashplayer/

Optional software

For the Linux (x86 platform), Flash player plug-ins are available for
the following browsers:

* Mozilla V1.0 or later

* Firefox V0.9.3 or later

* Konqueror V3.2.2 or later

For the Windows systems, Flash Player plug-ins are available for the
following browsers:

* Internet Explorer V4.0 or later

* Netscape Navigator V4 or later

* Netscape V6.3 or later

« AOL V7

* Mozilla V1.0 or later

* Opera Vo6

License requirements

When you purchased the WebSphere Message Broker for Multiplatforms
product, you specified the number of licenses that you required. Licenses are
measured in terms of processor license units (PLUs). For details of the
entitlements purchased with each license, see the Licensing Terms and
Conditions. The terms and conditions are displayed by the installation wizard.
You can view them after installation in your chosen language in directory
install_dir/license/.

Terms and Conditions are also supplied for third-party products used by
WebSphere Message Broker. The file containing these details is stored in the

same license subdirectory when you install one or more runtime components.

No Licensing Terms and Conditions or third-party Terms and Conditions are
displayed or stored when you install the Message Broker Toolkit.

For information about licenses on z/QOS, further details about license
agreements, or to make further purchases, contact your IBM representative.
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Chapter 2. Coexistence and migration

When you install WebSphere Message Broker Version 6.0, you can specify the
location into which it is installed, referred to as the install_dir. Because of this
flexibility of location, you can install WebSphere Message Broker Version 6.0
on a system that has another installation of Version 6.0, and previous product
versions, on all operating systems.

If you have more than one installation, the products can coexist, and you can
perform migration of components to Version 6.0 when you choose. The
following sections provide further details:

‘Coexistence”]

‘Migration and upgrade” on page 29|

Coexistence

Coexistence varies according to the operating system and the components that
you install. The components and their purpose are described in [Chapter 6,

[“Choosing what to install,” on page 61]

Runtime components on distributed systems

When you install WebSphere Message Broker runtime components on

distributed systems, the default action taken by the installation wizard
is to complete a typical installation, which installs all components into a
default directory.

The default directory for a typical installation is fixed and you cannot
change it. It includes the version and release of the product you are
installing in the format V.R (Version.Release), and has the following

values:

Linux /opt/ibm/mqsi/v.r

UNIX /opt/IBM/mgsi/v.r

Windows C:\Program Files\IBM\MQSI\v.r

Each unique version and release of the product is therefore installed
into a different default location.

The installation wizard differentiates only at version and release level;
it does not differentiate between different modification levels and fix
pack levels. The current modification level is 0 (Version 6.0.0). If a
later modification level is made available, it will install into the same
default location with a v.r value of 6.0, therefore upgrading the

Version 6.0.0 to the higher modification level (for example, Version
6.0.1).
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The wizard does not support installation of a previous modification
level or fix pack over a later one. The default action installs one fix
pack over a previous fix pack, but prohibits you from installing a
previous modification or fix pack over a later one.

You can install the product more than once at the same version and
release, in preference to upgrading the current installation. To achieve
concurrent installations, you must choose a custom installation and
specify a unique directory for each installation (one of which can be
the default directory). The installations at the same version and
release can be at the same modification or fix pack level, or at
different levels.

You can also use a custom installation to install into a non-default
directory, or to install a subset of the runtime components into the
default, or another, directory. If you have already installed one or
more of the runtime components in the specified directory, the
installation wizard indicates this situation on the panel on which you
choose further components. If you want to upgrade an existing
installation with a later version or release, you can achieve this task
with a custom installation. For example, if a Version 6.1 is released,
you could force this version to install over Version 6.0.

If you have never completed a typical installation of the product on
the system on which you have selected a custom installation, the
directory is initially set to the default directory, but you can change
this default value to your chosen value.

If you install the product more than once on any individual system, at
any version and release, the following restrictions apply:

* If you install the same version and release, for example 6.0, more
than once, the native installer support cannot manage these
installations in the normal way. See|“Native software installer|
[support” on page 28| for more details.

* Brokers associated with one installation cannot share a database
with brokers associated with a different installation.

* Components created in one installation cannot share a queue
manager with components created in a different installation.
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Files are also stored in the working directory, which depends on the
current ID with which you are logged on. The location depends on
the operating system:

Linux and UNIX /var/mgsi

Windows C:\Documents and Settings\All
Users\Application Data\IBM\MQSI

(C:\Documents and Settings\All
Users is the default setting; this setting
might have a different value on your
system.)

If you have multiple installations on a single system, you can review
the contents of the file install.properties, which is stored in the root
of the working directory. For each installation at Version 6.0 and
above, the file is updated with the location and the level.

This example shows the contents of install.properties on a
Windows system on which a single installation has completed:

C\:\\Program\ Files\\IBM\\MQSI\\6.0=6.0.0.0

(The backslash character \ is interpreted as an escape character. It is
inserted before each non-alphabetic and non-numeric character in the
string to preserve the character. A colon and several backslash
characters are escaped in this example.)

If you want to revert your installation to a previous level for any
reason, you must uninstall the current version and install the previous
product. Therefore back up any resources, for example databases, to
enable you to return to a previous state if you choose.

Because the version and release are included in the directory structure
when you complete a typical installation, and you have a free choice
of directory if you perform a custom installation, you can also install
Version 6.0 and later releases on the same system on which you have
already installed either Version 2.1 or Version 5.0. The installations can
coexist, and you can operate them independently. Coexistence of
Version 2.1 with Version 5.0 is not supported.

However, you cannot install Version 2.1 or Version 5.0 if you have
already installed Version 6.0; the installation programs fail. If you
want multiple versions on a single system, you must install Version
2.1 or Version 5.0 before you install Version 6.0.

There is no limit to the number of installations of Version 6.0 or later,
other than those imposed by the availability of system resources.
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This coexistence means that you can manage a migration from an
earlier version to Version 6.0 in a controlled manner, and do not have
to migrate all components at the same time. For more information, see
[“Migration and upgrade” on page 29|

Runtime components on z/OS

On z/0S you can install multiple copies of the runtime components
on the same system if you specify a different installation location for
each copy. The installations can run independently of each other. The
code can be at the same or at different version and release levels,
including Version 2.1 and Version 5.0. There are no restrictions other
than those imposed by the availability of system resources.

The default installation directory is /usr/1pp/mqsi/VxRxMx where
VxRxMx represents Version X, Release X, Modification X, for example,
V6ROMO.

For more details of locations, libraries, and file system paths, see the
Program Directory for WebSphere Message Broker for z/OS or the Program
Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS.

Message Broker Toolkit on Linux (x86 platform) and Windows
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Linux When you install the Message Broker Toolkit, the default
action taken by the installation wizard is to install all files into
the following directory:

/opt/ibm/MessageBrokersToolkit/v.r

You can install only Message Broker Toolkit Version 6.0;
previous versions of this component were available on
Windows only. Only one instance of the Message Broker
Toolkit can be installed on a single system.

The Message Broker Toolkit Version 6.0 can coexist with
multiple installations of runtime components, subject to the
restrictions described for those components.

Windows
When you install the Message Broker Toolkit, the default
action taken by the installation wizard is to install all files into
the following directory:

C:\Program Files\IBM\MessageBrokersToolkit\v.r

If you install the Message Broker Toolkit on Windows and you
specify your own directory location, be aware of the file
system limit of 256 characters imposed by NTFS. This limit
can cause restrictions in path specification to resources (for
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example, message flow projects), and might cause access
problems if the combination of path and resource name
exceeds this limit. Keep installation locations and resource
names short to avoid problems associated with this restriction.

The Message Broker Toolkit Version 6.0 can coexist with the
Message Brokers Toolkit for WebSphere Studio Version 5.0 or
Version 5.1 (but not both). Only one instance of the Message
Broker Toolkit of each version can be installed on a single
system.

The Message Broker Toolkit Version 6.0 can coexist with a
Version 2.1 Control Center.

The Message Broker Toolkit Version 6.0 can coexist with
multiple installations of runtime components, subject to the
restrictions described for those components.

Setting the environment for an installation

Because you can have more than one installation on a single system, you must
ensure that any commands that you issue on that system are directed to the
correct version of installed code.

* On Linux and UNIX systems, you must run the profile file mqsiprofile to
set up the correct environment before you run other WebSphere Message
Broker commands, for example, mqsicreatebroker. mqsiprofile is stored in
install _dir/bin.

If you add the profile file to your system logon profile, it is run
automatically for you whenever you log on.

* On Windows, a command console is available for each installation and you
must invoke commands in the window for a particular installation.
If you prefer, you can run the mqsiprofile.cmd file, which is stored in
install _dir\bin.

If you have an earlier version of this product installed on this system, check
that the earlier profile is not set for the current user ID. The two profiles are

incompatible and might cause unpredictable results.

This requirement is not applicable on z/OS systems.

For more details about mqsiprofile, see [Chapter 12, “What’s next,” on page|

Chapter 2. Coexistence and migration 27



Coexistence

Native software installer support

If you install the same version and release (for example, 6.0) more than once
on a single system, the native installer support cannot manage these
installations in the normal way.

To guarantee that you uninstall the correct installation, use the appropriate
uninstall program uninstaller in the _uninst_runtime directory of that
installation. For further information about uninstalling the product, see the
information center.

You can view the install.properties file to see current installations and their
locations, and check the operating system representation:

AIX  The first installation is recorded as mgsiv.r, for example mqsi60.
Subsequent installations at the same v.r level appear under the first
one when you list installed products with 1slpp. If you use smitty and
geninstall to manage those subsequent installations, results are
unpredictable.

Linux, HP-UX, and Solaris
The first installation is recorded as mgsiv.7, for example mqsi60.
Subsequent installations at the same v.r level are recorded as
mgsiv.r-2, and so on.

Windows
The most recent installation that you completed for any given version
and release appears in Add/Remove Programs. No other installations
are shown here. Similarly, the Command Console option in the Start
menu is that associated with the most recent installation.

If you uninstall the product at a specific version and release listed by
Add/Remove Programs, earlier installations you completed on the
system are not reinstated in that view.
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Migration and upgrade

Because you can install WebSphere Message Broker Version 6.0 on the same
system as previous versions and other installations of Version 6.0, you are not
required to complete any migration tasks before you install Version 6.0.

WebSphere Message Broker Version 6.0 can coexist with one of the following
products:

* WebSphere Business Integration Message Broker Version 5.0

* WebSphere Business Integration Event Broker Version 5.0

* WebSphere MQ Integrator Version 2.1

¢ WebSphere MQ Integrator Broker Version 2.1

* WebSphere MQ Event Broker Version 2.1

You can choose how and when to migrate resources and components,
according to the instructions provided in the information center.

As stated earlier, you are not required to back up any resources before you
install Version 6.0, although backing up resources such as your workspace
tiles before you migrate the Message Broker Toolkit ensures that you can
revert to a previous level. More information is provided in the migrating
section in the information center.

To review the migration information before you install, view a stand-alone or
online version of the information center. Access instructions are provided in
[“Where to find more information” on page xii

Upgrading to Version 6.0.0.1

If you are upgrading to Version 6.0.0.1 from Version 6.0.0.0, you have a choice
of how to complete the task. These options are summarized below. Further
details, including potential advantages, are described in [Chapter 9, ”Installing|
runtime components,” on page 85 and |Chapter 10, “Installing the Message
Broker Toolkit,” on page 91.]

The Message Broker Toolkit Version 6.0.0.1 interacts with runtime components
at Version 6.0.0.0; the Message Broker Toolkit Version 6.0.0.0 does not interact
with runtime components at Version 6.0.0.1. If you upgrade runtime
components, you must also upgrade your toolkit to Version 6.0.0.1.

Message Broker Toolkit
The following options are available to upgrade your existing
installation in its current location.
1. Use the Rational Product Updater (RPU).
Download the compressed file images to a system somewhere in
your network, and set up a common resource for multiple users to
upgrade your existing Version 6.0.0.0 Message Broker Toolkit in its
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current location. Alternatively, individual users can access the RPU
and install updates directly from the Internet.

Use the Version 6.0.0.1 CDs or DVDs. If you choose this option,
updates to any other Rational products that you have installed are
also required.

Access the download packages on Passport Advantage, if you are
registered with this scheme. If you choose this option, updates to
any other Rational products that you have installed are also
required.

Runtime components
The following options are available:
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1.

Use the Version 6.0.0.1 CDs or DVDs.

Upgrade an existing Version 6.0.0.0 installation in its current
location or install Version 6.0.0.1 at another location.

Access the download packages on Passport Advantage.

Upgrade an existing Version 6.0.0.0 installation in its current
location or install Version 6.0.0.1 at another location.



Chapter 3. National language support

When you install WebSphere Message Broker, the installation wizards detect
your current system locale and perform the installation process in the
associated language.

If your current system locale is not one of the supported languages (indicated
below), you must select a supported language from those listed in the dialog
box that is presented by the wizard before you can continue with the
installation. This language is used for the installation process only and does
not affect other processes on your computer.

After installation on distributed systems, the user interface and message
catalogs are provided in the following languages:
* Brazilian Portuguese

* French

* German

e Italian

* Japanese

* Korean

 Simplified Chinese

* Spanish

¢ Traditional Chinese

* US English

After installation on z/OS, the message catalogs are provided in the following
languages:

* Japanese

* Simplified Chinese

* US English

The messages written to the z/OS operator console (which are a subset of the
messages written to the joblog) are in US English only, and are written in
mixed case or in uppercase depending on your chosen system configuration.

WebSphere Message Broker provides a selection of message catalogs that are
used by the product components to report any problems that occur. If you use
other products in conjunction with WebSphere Message Broker, these might
cause WebSphere Message Broker to report errors using its message catalogs,
or might report problems using their own techniques.

Refer to the documentation supplied with any other products that you use to
determine the language support that they provide. In particular, check the

© Copyright IBM Corp. 2005,2006 31



National language support

documentation supplied by the databases that you use, and documentation
provided with any user-defined node or parser that you integrate into the

WebSphere Message Broker environment.

You can install WebSphere Message Broker and WebSphere MQ in any
supported language; all language versions for each product are compatible
with all language versions for the other product. All languages for the
WebSphere MQ messaging products are included on the WebSphere MQ
server CD supplied with WebSphere Message Broker.

All messages generated for internal inter-component message exchange (for
example, deployed configuration messages and log files for the mqsireadlog
command) are generated in code page 1208 (UTE-8).

Locales

WebSphere Message Broker supports messages for the following locales.

Table 6. Supported locales

AIX HP-UX? Linux? Solaris Windows z/OS

en_US en_US.is088591, |en_US en_US English (United En_US.IBM-1047,
en_US.roman8 States) En_US.IBM-037

de_DE, De_DE |de_DE.ISO88591, |de_DE de German (Standard) |Not supported
de_DE.roman8

es_ES, Es_ES es_ES.ISO88591, |es_ES es Spanish (Modern Not supported
es_ES.roman8 Sort)

fr_ FR, Fr_FR fr FRISO88591, |fr_FR fr French (Standard) Not supported
fr_ FR.roman8

it_IT, It_IT it_ITISO88591, |it_IT it Italian (Standard) Not supported
it_IT.roman8

pt_BR, Pt_BR pt_BR.ISO88591, |pt_BR pt_BR Portugese Not supported
pt_BR.utf8 (Brazilian)

Ja_JP, ja_JP ja_JP.SJIS, ja_JP ja_JPPCK, ja |Japanese Ja_JPIBM-939,
ja_JP.euc]P Ja_JP.IBM-930

Zh_CN, zh_CN |zh_CN.hp15CN |zh_CN zh, zh.GBK Simplified Chinese |Zh_CN.IBM-1388,

(China) Zh_CN.IBM-935

Zh_TW, zh_TW | zh_TW.big5, zh_TW zh_TW, Traditional Chinese |Not supported
zh_TW.eucTW zh_TW.BIG5 | (Taiwan)

ko_KR ko_KR.eucKR ko_KR ko Korean Not supported
Notes:

1. Due to limited syslog support on HP-UX, messages are written to the log
in US English only.
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2. These values are the same for Linux (POWER platform), Linux (x86
platform), and Linux (zSeries platform).

Other locales might be supported; check your operating system for further
details about locales.
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Chapter 4. Installation packages

This chapter describes the contents of your product package, which depend
on the product that you have ordered:

* WebSphere Message Broker for Multiplatforms or WebSphere Message
Broker with Rules and Formatter Extension for Multiplatforms

The package includes product code for five operating systems, plus other

optional software and documentation:

— A DVD that contains all required and optional code for Linux (x86
platform). The structure of the DVD content is described in [‘DVD
[contents” on page 36

— A DVD that contains all required and optional code for Windows. The
structure of the DVD content is described in ['DVD contents” on page 36.|

— A set of CDs for installation of runtime components and required
products on all operating systems. They are listed in [Table 8 on page 38

— A set of CDs for installation of the Message Broker Toolkit on both Linux
(x86 platform) and Windows. These are listed in [Table 9 on page 41|

— Supplemental CDs. These CDs contain additional products that you
might choose to install. These CDs are listed in [Table 10 on page 42| For
further information about why these products might be required, see
[“Optional software” on page 19.|

— If you have ordered WebSphere Message Broker with Rules and
Formatter Extension for Multiplatforms, your package includes the set
of CDs shown in(Table 11 on page 43| The Rules and Formatter extension
code is not included on DVD; you must install this extension from CD.

* WebSphere Message Broker for z/OS or WebSphere Message Broker with
Rules and Formatter Extension for z/OS

The package includes z/OS product code on tape, plus other optional

software and documentation. In addition, you receive the product for Linux

(x86 platform) and Windows, because the Message Broker Toolkit is

available only on those operating systems.

— A DVD that contains all required and optional code for Linux (x86
platform). The structure of the DVD content is described in
[contents” on page 36

— A DVD that contains all required and optional code for Windows. The
structure of the DVD content is described in [“DVD contents” on page 36.|

— A set of CDs for installation of runtime components and required
products on Linux (x86 platform) and Windows. They are included in
[Table 8 on page 38

© Copyright IBM Corp. 2005,2006 35



Installation packages

— A set of CDs for installation of the Message Broker Toolkit on Linux (x86
platform) and Windows. These are listed in [Table 9 on page 41|

— Supplemental CDs. These CDs contain additional products that you
might choose to install. These CDs are listed in [Table 10 on page 42| For
further information about why these products might be required, see
[“Optional software” on page 19|

- z/0S tapes

For information about tapes supplied with WebSphere Message Broker
for z/OS, see the Program Directory for WebSphere Message Broker for z/OS
or the Program Directory for WebSphere Message Broker with Rules and
Formatter Extension for z/OS.

DVD contents

DVDs (type DVD-R, size DVD-5) are supplied for Linux (x86 platform) and
Windows only. The DVD labels are WebSphere Message Broker V6.0 Linux
x86 and WebSphere Message Broker V6.0 Windows. The release date on the
DVD labels is April 2006.

These packages are marked with the symbol .

The DVDs contain code for the following products:

* WebSphere Message Broker Version 6.0.0.1 runtime components
* Message Broker Toolkit Version 6.0.0.1

* WebSphere MQ Version 6.0

* DB2 Enterprise Server Version 8.2

* DB2 Run-Time Client Version 8.2 (Windows only)

* Rational Agent Controller Version 6.0.1

If you install on Windows using the Launchpad (described in
[“Installing with the Windows Launchpad,” on page 75), the Launchpad
navigates the DVD to find the products and components that you have
chosen to install, and you do not have to be familiar with the structure of the
DVD contents.

If you install on Linux (x86 platform), or you install on Windows and choose
not to use the Launchpad, use the DVD structure shown in [Table 7 on page 37|
to find what you want.

If you have ordered WebSphere Message Broker with Rules and Formatter
Extension, you must install the extension from CD; it is not supplied on DVD.
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Table 7. DVD contents

DVD contents

Directory

Description

\ (root)

* Runtime components installation files Version 6.0.0.1
* (Windows only) Launchpad and Quick Tour?!

\DB2_Enterprise_Server_ V8.2

DB2 Enterprise Server Version 8.2

\DB2_Runtime_Client V8.2

(Windows only) DB2 Runtime Client Version 8.2

\ibmjre

(Windows only) Java Runtime Environment

\installation_guide

Installation Guide PDF files (US English only)

\license

License files used by the installation wizard (US English and
translations)

\Message_Broker_Toolkit V6

Message Broker Toolkit installation images

\Rational_Agent_Controller_V6

Rational Agent Controller Version 6.0.1 installation images

\readmes

WebSphere Message Broker readme.html files (US English and
translations)

\sample-scripts

Sample response files for installing and uninstalling

\WebSphere_MQ V6.0

WebSphere MQ installation images

Notes:

1. This item is a stand-alone executable version of the Quick Tour, which is
available on Windows only. On Linux (x86 platform) and Windows, you
can access the Quick Tour from the Message Broker Toolkit.
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Runtime component CDs
The CDs listed in are supplied for installation of runtime components

and associated products.

The packages are marked with the symbol .

The release date on the CD labels for these components is February 2006

unless otherwise stated.

Table 8. CDs supplied for WebSphere Message Broker for Multiplatforms runtime components and

associated products

Operating CD label Description

System

AIX WebSphere Message Broker V6.0 AIX (Runtime |Product code Version 6.0.0.1

Disk 1)

Release date April 2006

WebSphere MQ for AIX V6.0 (Runtime Disk 2)

Product code

DB2 V8.2 for WebSphere Broker products - AIX
(Runtime Disk 3) - English/French/German/
Ttalian

Product code and documentation

DB2 V8.2 for WebSphere Broker products - AIX
(Runtime Disk 3) - English/Spanish/Brazilian
Portuguese

Product code and documentation

DB2 V8.2 for WebSphere Broker products - AIX
(Runtime Disk 3) - English/Japanese/Korean/
Simplified Chinese/Traditional Chinese

Product code and documentation

HP-UX (PA-RISC
platform)

WebSphere Message Broker V6.0 HP-UX
(Runtime Disk 1)

Product code Version 6.0.0.1

Release date April 2006

WebSphere MQ for HP-UX V6.0 (Runtime Disk
2)

Product code

DB2 V8.2 for WebSphere Broker products -
HP-UX (Runtime Disk 3)

Product code and documentation
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Table 8. CDs supplied for WebSphere Message Broker for Multiplatforms runtime components and
associated products (continued)

Operating CD label Description
System
Linux (POWER | WebSphere Message Broker V6.0 Linux Product code Version 6.0.0.1
platform) (POWER platform) (Runtime Disk 1)
Release date April 2006
WebSphere MQ for Linux (POWER platform) Product code
V6.0 (Runtime Disk 2)
Release date April 2006
DB2 V8.2 for WebSphere Broker products - Product code and documentation
Linux (POWER platform) (Runtime Disk 3)
Release date April 2006
Linux (x86 WebSphere Message Broker V6.0 Linux x86 Product code Version 6.0.0.1
platform) (Runtime Disk 1)

Release date April 2006

WebSphere MQ for Linux x86 V6.0 (Runtime
Disk 2)

Product code

DB2 V8.2 for WebSphere Broker products -
Linux x86 (Runtime Disk 3)

Product code and documentation

Linux (zSeries
platform)

WebSphere Message Broker V6.0 Linux zSeries
(Runtime Disk 1)

Product code Version 6.0.0.1

Release date April 2006

WebSphere MQ for Linux zSeries V6.0 (Runtime
Disk 2)

Product code

DB2 V8.2 for WebSphere Broker products -
Linux zSeries (Runtime Disk 3)

Product code and documentation

Solaris (SPARC
platform)

WebSphere Message Broker V6.0 Solaris SPARC
(Runtime Disk 1)

Product code Version 6.0.0.1

Release date April 2006

WebSphere MQ for Solaris SPARC V6.0
(Runtime Disk 2)

Product code

DB2 V8.2 for WebSphere Broker products -
Solaris SPARC (Runtime Disk 3)

Product code and documentation

Chapter 4. Installation packages 39



Runtime component CDs

Table 8. CDs supplied for WebSphere Message Broker for Multiplatforms runtime components and
associated products (continued)

(Runtime Disk 1)

Operating CD label Description
System
Solaris (x86-64 WebSphere Message Broker V6.0 Solaris (x86-64 | Product code Version 6.0.0.1
platform) platform) (Runtime Disk 1)
Release date April 2006
WebSphere MQ for Solaris (x86-64 platform) Product code
V6.0 (Runtime Disk 2)
Release date April 2006
DB2 V8.2 for WebSphere Broker products - Product code and documentation
Solaris (x86-64 platform) (Runtime Disk 3)
Release date April 2006
Windows WebSphere Message Broker V6.0 Windows ¢ Runtime components installation

files Version 6.0.0.1
* IBM DB2 Run-Time Client V8.21
¢ Launchpad and Quick Tour?
* License files3
* Readme files?
* Installation Guides?
¢ Sample scripts?
Release date April 2006

WebSphere MQ for Windows V6.0 (Runtime
Disk 2)

* Product code
¢ Launchpad and Quick Tour?
Release date April 2006

IBM DB2 V8.2 for WebSphere Broker products -
Windows (Runtime Disk 3)

* Product code and
documentation

* Launchpad and Quick Tour?

Release date April 2006

Notes:

1.

Install this product to install the ODBC Drivers for Cloudscape that are

required if you want to use the Derby embedded database in the broker

component.

['DVD contents” on page 36.|
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Message Broker Toolkit CDs

The CDs shown in [Table 9| are supplied for the Message Broker Toolkit
installation. The product code includes the information center.

The packages are marked with the symbol .

The release date on the CD labels for this component is February 2006 unless

otherwise stated.

Table 9. CDs supplied for Message Broker Toolkit

Operating CD label Description
System
Linux (x86 WebSphere Message Broker Toolkit V6.0 Disk 1 | Product code Version 6.0.0.1
platform) (Linux x86)
Release date April 2006
WebSphere Message Broker Toolkit V6.0 Disk 2 | Product code
(Linux x86)
WebSphere Message Broker Toolkit V6.0 Disk 3 | Product code
(Linux x86)
WebSphere Message Broker Toolkit V6.0 Disk 4 | Product code
(Linux x86)
WebSphere Message Broker Toolkit V6.0 Disk 5 | Product code
(Linux x86)
Windows WebSphere Message Broker Toolkit V6.0 Disk 1 |+ Product code Version 6.0.0.1

(Windows)

* Launchpad and Quicktour!
* License files?

* Readme files?

* Installation Guides?
Release date April 2006

WebSphere Message Broker Toolkit V6.0 Disk 2
(Windows)

Product code

WebSphere Message Broker Toolkit V6.0 Disk 3
(Windows)

Product code

WebSphere Message Broker Toolkit V6.0 Disk 4
(Windows)

Product code

WebSphere Message Broker Toolkit V6.0 Disk 5
(Windows)

Product code

Notes:

1. This item is a stand-alone executable version of the Quick Tour.
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2. These items are identical to equivalent items on the DVD, as described in
['DVD contents” on page 36.|

Supplemental CDs
The CDs listed in [Iable 10|are supplied for supplemental (optional) products.

The packages are marked with the symbol .

The release date on the CD labels is April 2006 unless otherwise stated.
Table 10. Supplemental CDs supplied with WebSphere Message Broker

Operating CD label Description
System
Multiplatforms | WebSphere Documentation? Documentation
Rational Agent Controller V6.0.1 Product code and documentation for
all supported broker platforms
WebSphere MQ Everyplace Version 2.0.2.0 Product code
Release date October 2005

Notes:

1. The WebSphere Documentation CD contains an integrated information
center which includes documentation plug-ins for WebSphere Message
Broker, WebSphere Event Broker, WebSphere MQ Version 6.0, and
WebSphere MQ Everyplace Version 2.0.2. For more information about how

ou can use this information center, see|“Where to find more information”|
On page Xii.

42  Installation Guide




Rules and Formatter Extension CDs

Rules and Formatter Extension CDs

If you have purchased WebSphere Message Broker with Rules and Formatter
Extension for Multiplatforms, your package also contains the CDs listed in
able 11} The contents of these CDs are not included on the DVDs.

The packages are marked with the symbol

The release date on the CD labels for the Rules and Formatter Extension is

April 2006.
Table 11. Additional CDs supplied for WebSphere Message Broker with Rules and Formatter Extension
Operating CD label Description
System
AIX Rules and Formatter Run-time Extension V6.0 Product code and documentation

AIX

HP-UX (PA-RISC

Rules and Formatter Run-time Extension V6.0

Product code and documentation

platform) HP-UX
Linux (x86 Rules and Formatter Run-time Extension V6.0 | Product code and documentation
platform)? Linux x86

Rules and Formatter Design-time Extension
V6.0 Linux x86

Product code and documentation

Linux (zSeries

Rules and Formatter Run-time Extension V6.0

Product code and documentation

platform) Linux zSeries

Solaris (SPARC | Rules and Formatter Run-time Extension V6.0 | Product code and documentation
platform)? Solaris

Windows Rules and Formatter Run-time Extension V6.0 Product code and documentation

Windows

Rules and Formatter Design-time Extension
V6.0 Windows

Product code and documentation

Notes:

1.

The Rules and Formatter Run-time Extension is not available for either

Linux (POWER platform) or Solaris (x86-64 platform).
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Part 2. Preparation

This part describes the tasks that you might need to complete before you start
installation of WebSphere Message Broker. The information here addresses
z/06S and distributed systems.

+ [Chapter 5, “Preparing the system,” on page 47|

* [Chapter 6, “Choosing what to install,” on page 61]

* [Chapter 7, “Choosing an installation mode,” on page 65
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Chapter 5. Preparing the system

Before you install WebSphere Message Broker, there are several tasks that you
must complete on some operating systems. There are other tasks you might
want to complete, depending on your installation intentions.

If you are installing on a distributed system or on z/OS, read the following
section:
* [‘Setting up security”]

If you are installing on a distributed system, read the following section:
¢ [‘Accessing CDs and DVDs” on page 51|

If you are installing on HP-UX or Solaris, read the following section:
¢ [’Checking the kernel configuration” on page 57

When you have completed these tasks, follow the installation instructions in
the appropriate chapter:

¢ [Chapter 8, “Installing with the Windows Launchpad,” on page 75|

* [Chapter 9, “Installing runtime components,” on page 85

« [Chapter 10, “Installing the Message Broker Toolkit,” on page 91|

Setting up security

This section describes security requirements:

* To install the product

« To complete the procedures described in [Chapter 11, “Configuring and]
[verifying your system,” on page 107

After installation, check the topics under the Security heading in the
information center to review and implement the security requirements for
additional users doing other tasks.

Security control of WebSphere Message Broker components, resources, and
tasks depends on the definition of users and groups of users (principals) to
the security subsystem of the operating system. Check that you have the
correct authority, and that the required principals are in place, before you
install WebSphere Message Broker.

On Windows systems, user IDs can be up to 12 characters long but on Linux

and UNIX systems, and on z/OS, they are restricted to eight characters. You
might also be restricted to user IDs of eight characters by your broker
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database; for example, DB2 has this limit. If you have a mixed environment,
ensure that the user IDs you use within the broker domain are limited to a
maximum of eight characters.

You must also ensure that the case (upper, lower, or mixed) of user IDs in
your broker domain is consistent. In some environments, upper case and
lower case user IDs are considered the same but in other environments, user
IDs of different case are considered unique. For example, on Windows the
user IDs tester and TESTER are identical but on Linux and UNIX systems
they are recognized as different user IDs.

In addition, check the validity of spaces and special characters in user IDs to
ensure that, if used, these can be accepted by all relevant systems and
products in your broker domain.

+ If you are installing on Linux or UNIX systems, go to[“Security on Linux
fand UNIX systems.”]

o If iou are installing on Windows, go to[Security on Windows systems” on|

« If you are installing on z/OS, go to[“Security on z/OS systems” on page 51,

Security on Linux and UNIX systems

Before you install WebSphere Message Broker, you must set up the required
security.

Use the security facilities provided by your operating system to complete
these tasks, for example, SMIT on AIX or the System Administration Manager
(SAM) on HP-UX.

Complete the following actions:

1. Log in to the system. Your user ID must have root authority to complete
installation. Follow your local security guidelines to acquire root authority;
either log in as root, or log in as another user and become root.

The use of a user ID other than root itself has some advantages; it
provides an audit trail of the user ID that performs installation and it
limits the scope of root authority to tasks performed in a single session. It
might also be required if you are logging in from a remote system.

If you are installing only the Message Broker Toolkit on Linux (x86
platform), you must complete only this action.

2. Create a new security group called mqgbrkrs.
3. Add the user ID that you logged in with to the group mgbrkrs.

If you are installing on a system that will run as a production server (with
the broker and perhaps Configuration Manager components installed),
create an additional new user ID for use only with product components. If
you create a new ID, add it to the mqbrkrs group.
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On a Linux (x86 platform) system that you are running as a development
or test system, you can use the ID you logged in with to complete
installation.

4. If you have already installed WebSphere MQ on this system, a group
called mqm and a user called mgm have already been defined. If you have
not yet installed WebSphere MQ, you must create this user and group.

5. Add the user ID that you logged in with, the new user ID (if you created
one), and the user ID mgm to the group mqm.

6. To complete installation verification on Linux (x86 platform) only, you do
not require root authority. If you do not want to complete verification with
root authority, log off when you have completed installation. Log in with
the same or a different user ID, but do not become root. If you have not
already done so, add that user ID to the groups mqgbrkrs and mgm before
you launch the Message Brokers Toolkit.

Security on Windows systems

Before you install WebSphere Message Broker runtime components or the
Message Broker Toolkit, you must log on with a user ID that has
Administrator authority, but is not the Administrator ID.

If you are installing the runtime components, the installation wizard calls the

mgqsisetsecurity command which completes the following tasks:

1. Creates a new security group called mqbrkrs.

2. Adds your current (logged on) user ID to the group mqbrkrs.

3. Adds your current user ID to the group mqm, if that group exists.
The mqm group exists if have already installed WebSphere MQ on this
system. If you have not, call the mqsisetsecurity command when you
have completed WebSphere MQ installation. If you use the Windows

Launchpad (described in [Chapter 8, “Installing with the Windows|
[Launchpad,” on page 75), it completes WebSphere MQ installation first.

If you prefer to create principals before you install WebSphere Message
Broker, use the security facilities provided by the Windows Control Panel to
complete these tasks.

If you are running Terminal Services on this system, you must also change
user mode to ensure that actions taken during installation are completed
correctly, for example the creation of ini files and other related files in the
default system directory C:\Windows. If you do not make this change, files
might be written to other locations and, although the installation might
complete successfully, the product might not work as expected.
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Enter the following command to change user mode before you install any
product components:

change user /install

When installation is complete, enter the following command to restore the
original user mode:

change user /execute

To complete verification, your user ID must have Administrator authority. If
you log in with a different user ID to that with which you perform
installation, you must add that user ID to the groups mqgbrkrs and mqm. Use
either the Windows security facilities or the mqsisetsecurity command (run
this command after you have logged on with that different ID) to complete
these additions.

Security in a domain environment

If you intend to install in a Windows domain environment, you must decide
whether you want to install WebSphere Message Broker on the domain
controller.

* If you install WebSphere Message Broker on the domain controller:

1. Install on the domain controller before you install on any of the domain
workstations.

The WebSphere Message Broker installation program creates the
mgbrkrs local group only if you have Domain Administrator authority;
if you do not have this authority when you install, create this group at a
later time.

In a domain environment, WebSphere Message Broker also requires a
global group, Domain mgbrkrs, which you must create using Windows
security facilities. You must also add Domain mqbrkrs to the local group
mgbrkrs.

2. Install on each workstation that is a member of the same domain. The
WebSphere Message Broker installation program creates the mgbrkrs
local group. Add the Domain mgbrkrs global group to the local mqbrkrs
group.

* If you do not install WebSphere Message Broker on the domain controller
system:

1. Create the Domain mqbrkrs global group on the domain controller
system.

2. Install on each workstation in the domain. After installation has
completed, add the Domain mqbrkrs global group to the local group.
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Security on z/OS systems

The user ID that you use to install the product must be no more than eight
characters in length. It must also have suitable RACF® privileges to perform
SMP/E installation in your environment. The user ID must have a valid
OMVS segment, because the product installs into the file system paths
specified during the SMP/E APPLY processing.

Accessing CDs and DVDs

When you install or upgrade WebSphere Message Broker, you can access CDs
or DVD on the local system, or you can set up a shared drive and install
several systems from that shared resource.

The information in the following sections is relevant to both CDs and DVDs.
All references are to CDs; DVD behavior is identical. DVDs are available for
Linux (x86 platform) and Windows only.

You can also install or upgrade from downloaded images of the software
obtained from Passport Advantage, if you are registered with this scheme. If
you want to use this option, read the instructions that are provided with the
packages which explain how to download and extract the images. Use this
section to set up local or remote access to these images in the same way as for
a CD or DVD.

If you are installing on Windows, you cannot enter a UNC path
(\\server\drive) to access the installation program; you must map the drive,
as shown in a later example, otherwise the Java process times out. If you
cannot map the drive, or choose not to, copy the CD contents to a local drive
and install from that drive.

For local installations, see [“Accessing CDs and DVDs on the local system”} for
remote installations, see[”Accessing CDs and DVDs on a remote system” on|

Accessing CDs and DVDs on the local system

If you want to install product components from a local CD or DVD, complete
this task. Always consult your operating system documentation for exact
details of this task.

AIX

1. Log in and ensure your user ID has root authority.

2. Complete the security setup described in|“Security on Linux and|
[UNIX systems” on page 48
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HP-UX
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DVDs locally

3. Create a CD mount point directory:
mkdir /cdbroker

where /cdbroker is the mount point.

4. Insert the CD that you want to access in the drive of the system
on which you want to install one or more product components.

5. Use SMIT to mount the CD, or use the following command:
mount -r -v cdrfs /dev/cd@ /cdbroker

where /dev/cd0 is the CD device and /cdbroker is the mount point.

6. You are now ready to install the product that is supplied on this
CD.

The HP-UX CDs have the format ISO 9660, with Rockridge extensions
enabled. If volume management software is in use, the CD mounts
automatically when you insert it into the CD drive. Alternatively, you
can mount the CD as described in the following procedure

If the CD is mounted incorrectly, some of the files cannot be read. The
installation fails with corrupt directory errors. It is important that you
check that the CD is mounted with Rockridge extensions enabled.

1. Log in and ensure your user ID has root authority.

2. Complete the security setup described in |”Security on Linux and|
|UNIX systems” on page 48.|

3. Create a CD mount point directory and grant read-only access to
all users:

mkdir /cdbroker
chmod 775 /cdbroker

where /cdbroker is the mount point.

4. Insert the CD that you want to access in the drive of the system
on which you want to install one or more product components.

5. Mount the CD using the following command:
mount -F cdfs /dev/dsk/device /cdbroker

where /device is the CD device, for example /c0t0d0 and /cdbroker
is the mount point.

6. You are now ready to install the product that is supplied on this
CD.
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Linux

—

Log in and ensure your user ID has root authority.

2. Complete the security setup described in [“Security on Linux and)
[UNIX systems” on page 48|

3. Create a CD mount point directory:
mkdir /cdbroker

where /cdbroker is the mount point.

4. Insert the CD that you want to access in the drive of the system
on which you want to install one or more product components.

5. Run the following command:
mount -0 ro -t 1509660 /dev/cdrom /cdbroker

where /dev/cdrom is the name of your CD device, for example
/dev/hdc, and /cdbroker is the mount point.

6. You are now ready to install the product that is supplied on this
CD.
Solaris

1. Log in and ensure your user ID has root authority.

2. Complete the security setup described in|’Security on Linux and|
|UNIX systems” on page 48.|

3. Insert the CD that you want to access in the drive of the system
on which you want to install one or more product components.
4. Enter the following command to check if the Volume Manager is
running on your system:
/usr/bin/ps -ef | /bin/grep vold

If the Volume Manager is running, the CD is mounted on
/cdrom/vol_label automatically, where vol_label is the volume
label of the current CD, for example wmb6_sol for Runtime Disk 1.

5. If the Volume Manager is not started, run the following
commands to mount the CD:

mkdir -p /cdbroker
mount -F hsfs -o ro /dev/dsk/cdrom /cdbroker

where /dev/dsk/cdrom is the CD location, for example c0t0d0 and
/cdbroker is the mount point directory.

Check where your CD is located using the command iostat -En.
Alternatively, use the volcheck command to mount a CD device
automatically.

6. You are now ready to install the product that is supplied on this
CD.
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Windows

1. Log on with a user ID that has Administrator authority, but is not
the Administrator ID.

2. Complete the security setup described in [“Security on Windows|
[systems” on page 49

3. Insert the CD that you want to access in the drive of the system
on which you want to install one or more product components.

4. You are now ready to install the product that is supplied on this
CD.

Accessing CDs and DVDs on a remote system

If you want to install product components from a remote (server) CD or DVD,
complete this task. Always consult your operating system documentation for
exact details of this task.

If you want to perform more than one installation of one or more
components, you might find that a remote server setup provides some
performance benefits, particularly for the Message Broker Toolkit which is the
largest component. You might also find this method more convenient if you
want to run installations in silent mode.

If you want to install the Message Broker Toolkit in silent mode, and you
cannot install from DVD, you must make a copy of the installation images
onto a disk drive, as described here, to avoid the requirement to swap CDs
during the process.

To enable a remote installation, you must complete tasks on both the server
system (the computer on which the CD, DVD, or shared drive is mounted)
and each target system (on which you want to install the product). For details
of the commands used in these examples, refer to the operating system
documentation.

You can use these instructions if you want to install, from a server, other
products that are supplied with WebSphere Message Broker, for example DB2
Enterprise Server. However you must check with the appropriate associated
product documentation to ensure that remote installation is supported.

Setting up the server system
You can either share the CD drive on the server, or make a copy of the
installation images on a disk and share the directory on that disk.

You can share a CD drive on Linux or UNIX with any other supported Linux

or UNIX system, but not with Windows. You can share a Windows CD drive
only with other Windows systems.
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1. If you want to share a copy of the installation image, create the copy:
a. Create a directory on the server to store the installation images:

Linux and UNIX
Enter the following command:

mkdir /instbroker

where instbroker is the directory into which you will
copy the product files.

Windows Enter the following command:
md m:\instbroker

where m is the drive on which you want to store the
installation images and instbroker is the directory on
that drive.

If you are creating directories for the Message Broker Toolkit on Linux
(x86 platform) or Windows, you must create all five disk subdirectories
in the same directory, for example:

/instbroker/diskl

/instbroker/disk2

/instbroker/disk3

/instbroker/disk4

/instbroker/disk5

where each subdirectory, for example diskl, is the root level of the
corresponding CD image.

This structure ensures that the installation program does not prompt
for location, and does not fail because it cannot find the right images.

b. Insert and mount the appropriate CD in the drive as described in
[“Accessing CDs and DVDs on the local system” on page 51| The
installation programs for the runtime components and the Message
Broker Toolkit are on separate CDs; insert the correct CD for the
components you want to install from this server.

If you have inserted a runtime or toolkit CD on Windows, the
Launchpad is invoked if autrorun is enabled. When the initial window
opens, click Cancel to close it.

c. Copy the complete contents of the CD to the new directory.

Linux and UNIX
Enter the following command:

cp -rf /cdrom/. /instbroker

Windows Enter the following command:
xcopy f:\*.* m:\instbroker /e

where f is the CD drive.
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2. Grant users access to the drive that contains the product code. These
instructions are the same for a disk drive on which you have copied the
CD contents, and for the CD drive itself.

AIX

Either type smit and click Communications Applications
and Services > NFS > Network File System (NFS) > Add
a Directory to Exports List, or enter the fastpath command
smitty mknfsexp. Complete the fields as appropriate and
press Enter.

HP-UX and Linux

Solaris

Windows

Use the exportfs command. The example below gives all
users read-only access using NFS:

exportfs -i -0 ro /instbroker
exportfs -a

where /instbroker represents the CD drive or the directory
containing the CD copy.

Use the share and exportfs commands. The example
below gives all users read-only access using NFS:

share -F nfs -o ro -d "Broker LAN server" /instbroker
exportfs -a

where "Broker LAN server” is an optional description and
/instbroker represents the server CD drive or directory
containing the CD copy.

Open Windows Explorer and right-click the drive that you
want to share. Click Sharing and follow the instructions
on the Properties dialog box.

Setting up the target system
On Linux and UNIX systems, create a new directory to mount the shared
directory. Enter the following command:

1.
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mkdir /remotebroker

where remotebroker is the name of the new directory.

Access the remote directory:

Linux and UNIX

Enter the following command:

mount machine name:instbroker /remotebroker

where machine name is the name of the system on which
you created the CD copy.



Windows

Accessing CDs and DVDs remotely

Connect to the appropriate drive and folder using the net
use command at a command prompt on the target
machine, for example:

net use x: \\server_name\instbroker

where x: is the required mapped drive on the target
machine.

If your shared installation directory name contains spaces
(for example, Broker Image), enclose it in quotes.

If your server is protected, you might need to specify a
user ID and password on this command (see the Windows
online help for more information about net use).
Alternatively, use Windows Explorer or some other
method to map the shared resource to a drive letter.

You cannot enter a UNC path (\\server\drive) to access
the installation program; you must map the drive, as
shown, otherwise the Java process times out. If you cannot
map the drive, or choose not to, copy the CD contents to a
local drive and install from that drive. In addition, you
cannot enter a UNC path when the installation wizard
requests a path as input; the wizard cannot interpret a
UNC path.

3. Change to the remote image directory. You are now ready to install the
product in that directory.

Checking the kernel configuration

On HP-UX and Solaris systems, check the current values of the system kernel
configuration parameters, and increase any values to the minimum values that
are recommended for the operation of WebSphere Message Broker.

Follow these steps:

1. Check the recommended values for the following products:

. WebSihere Message Broker; see [Figure 1 on page 58| and [Figure 2 onl

* WebSphere MQ); see the Quick Beginnings book for your operating
system for the version of WebSphere MQ that you have installed.

¢ DB2, if installed.
* Any other software that you are running that provides recommended

values.

Chapter 5. Preparing the system 57



Checking the kernel configuration

2. Take the highest value for each parameter and compare it to the
corresponding value in your kernel configuration.

3. If the current value is lower than the highest recommended value, update
the current setting using the appropriate tool (for example, SAM on
HP-UX). If the current value is higher, leave it unchanged.

4. On Solaris, increase the maximum number of concurrent open file
descriptors on your system to at least 256.

5. If you have changed any kernel values, restart your system for these

changes to take effect.

HP-UX

maxdsiz 0x40000000
maxssiz 0x08000000
max_thread_proc 1024
maxusers 32

msgmap 258 (msgtql +2)
msgmax 4096

msgmnb 4096

msgmni 50

msgseg 1024

msgssz tbs

msgtql 256

sema 1

semaem 16384

semmni 1024 (semmni<semmns)
semmap 1026 (semmni +2)

semmns 16384
semmnu 2048
semume 256
semvmx 32767
shmmax 4194304
shmem 1

shmmni 1024
shmseg 1024

Figure 1. Recommended values for HP-UX kernel configuration parameters
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Solaris

Twp_default_stksize =

rpcmod:
shmsys:
shmsys:
shmsys:
shmsys:
Semsys:
semsys:
Semsys:
Semsys:
Semsys:
Semsys:
Semsys:
Semsys:
semsys:
msgsys:

svc_run_stksize

shminfo_shmmax =
shminfo_shmseg =
= 1024

shminfo_shmmni
shminfo_shmmin

seminfo_semaem =
= 1024 (semmni < semmns)

seminfo_semmni

seminfo_semmap =

seminfo_semmns
seminfo_semms]

seminfo_semopm =
seminfo_semmnu =
seminfo_semume =
seminfo_semvmx =
msginfo_msgmap =

Checking the kernel configuration

0x4000

0x4000
4194304
1024

8
16384

1026 (semmni +2)
16384

= 125

100
2048
256
32767
1026

Figure 2. Recommended values for Solaris kernel configuration parameters
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Chapter 6. Choosing what to install

WebSphere Message Broker consists of four runtime components and the
Message Broker Toolkit.

Runtime components
The runtime components are available on all supported operating
systems. On distributed systems, you can choose to install one or
more components; when you install on z/OS, all the runtime
components are installed; you cannot choose to install a subset.

Broker

The broker is a set of execution processes that provides
message processing facilities that interact with a variety of
application clients using both point-to-point and
publish/subscribe communications. The message flows that
you create are hosted by the broker. You define how messages
are received, processed, and delivered to receiving
applications or subscribers. A broker can host many message
flows, in one or more execution groups, and can support
many clients.

The broker creates and maintains state and local configuration
data in a database. You must install and initialize a suitable
database before you create a broker, although you can install
the broker without a database being present on the system,
and install the database at a later time. For information about
supported databases, see ['Databases” on page 9/

Transformation Services

© Copyright IBM Corp. 2005,2006

Transformation Services provides message processing services
that extend the capabilities of the broker. You can install this
component only if you install the broker component.
Enhancements and extensions include the following
processing options:

* Additional message processing nodes to support enhanced
message processing, routing, and transformation, some of
which you can customize with mapping, ESQL, and Java

* Additional input and output nodes to interact with a wider
variety of application clients

* Creation of message models to define message structures
determined by C and COBOL data structures, industry
standards such as SWIFT or EDIFACT, and XML DTD or
schema, and agreed by senders and receivers
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* Development of user-defined extensions (nodes and
parsers) to support message processing options not
provided by the supplied nodes and parsers

* Message flow debug to step through processing to check
paths and results

* Message flow aggregation to manage multiple requests and
responses generated by a single input message

Configuration Manager
A Configuration Manager is an interface between the Message
Broker Toolkit and a set of one or more brokers, that controls
the resources in a broker domain. It maintains the
configuration details of the domain, and disseminates the
updates and additions that you make to that domain in the
Message Broker Toolkit.

The Configuration Manager creates and maintains the
configuration data for the domain in an internal repository.

User Name Server
A User Name Server is an optional component that provides
authentication for publish/subscribe environments, using
access control lists based on operating system definitions.
Install this component only if you want to restrict the
publish/subscribe activity of users or groups.

A single User Name Server to handle the publish/subscribe
authentication within a broker domain is typically sufficient; if
you have heavy publish/subscribe message traffic and a large
number of users, you might want to consider more that one
User Name Server. See the additional information about this
option in the information center.

If you are migrating from Version 2.1 or Version 5.0, and you
already have a User Name Server that provides
publish/subscribe authentication within your domain, you do
not need to install another one, because the User Name Server
is unchanged in function in Version 6.0.

You can install any combination of these components, and you can
install them more than once on any system. For more details about
how different installations can coexist, see |Chapter 2, “Coexistence]
land migration,” on page 23

For installation of runtime components, you can choose between a
typical installation and a custom installation. These are explained in
[Chapter 2, “Coexistence and migration,” on page 23
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Message Broker Toolkit

The Message Broker Toolkit is an integrated development
environment and graphical user interface based on the Eclipse
platform and the Rational framework.

Application developers work in separate instances of the Message
Broker Toolkit to develop message flows, message sets, and
user-defined nodes and parsers.

You can connect the Message Broker Toolkit to one or more
Configuration Managers, and manage the broker domains through
those Configuration Managers, for example by deploying resources to
brokers, and starting and stopping resources.

You can access a shared repository (for example, CVS) to store
resources and make them accessible in a secure manner to multiple
users.

The Message Broker Toolkit is available only on Linux (x86 platform)
(excluding Red Hat Enterprise Advanced Server V4) and Windows.

able 12| summarizes which components you can install on each operating

system.

Table 12. Installation choices

Operating system

Broker |Transformation | Configuration |User Name Message
Services Manager Server Broker Toolkit

AIX

‘/

HP-UX

Linux (POWER
platform)

Linux (x86 platform)

Linux (zSeries platform)

Solaris

Windows

z/0S

ANAVYAYAYA YR WA VA
NIN YN [Y] Y Y)Y
NN YN [Y] XX

NYNIY[Y Y] X [Y]X
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Chapter 7. Choosing an installation mode

Choose the mode that you want to use to install WebSphere Message Broker
from the following options:

+ On Windows only, [“The Windows Launchpad]

* [‘Graphical mode”|

* [’Console mode” on page 66|

* [‘Silent mode” on page 67]

There are different reasons to choose each of these modes, and these are
discussed in the appropriate sections. When you have chosen the mode that
you want to use, follow the installation instructions:

* [Chapter 8, “Installing with the Windows Launchpad,” on page 75|

* [Chapter 9, “Installing runtime components,” on page 83

* [Chapter 10, “Installing the Message Broker Toolkit,” on page 91|

The Windows Launchpad

On Windows, the Launchpad is the preferred and the default mode of
installation. The Launchpad helps you through the installation process for
WebSphere Message Broker and its prerequisite products (required for
runtime components only). You can either install them individually following
the Launchpad prompts, or request that the Launchpad installs your selected
products for you using default options.

From the Launchpad you can also view this book in PDF format, review the
readme file readme.html, and launch the Quick Tour (see |Chapter 11,|
[“Configuring and verifying your system,” on page 107 for further
information).

The Launchpad exists on the DVD, and on every CD from which product
components or prerequisite products might be installed, and, if autorun is
enabled, starts automatically when you insert a CD or DVD.

Graphical mode

The installation wizard runs in graphical mode if you start it with no options
(this mode is the default option). The wizard guides you through the
installation process with a series of panels that present options and defaults.
You can accept the default values, or change them to suit your environment
and requirements.
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Graphical mode provides the highest level of information and guidance to
help you complete an installation. Use graphical mode when you are
unfamiliar with the product, or if you want to monitor the installation
progress.

The name of the installation wizard for your operating system is listed in
[“Installation wizard names” on page 72

If you click Cancel before the Install Progress panel appears, you can exit the
setup. If you decide to exit, your system returns to the state it was in before
the installation wizard was launched. However, if you cancel the installation
wizard after installation has completed, and the final summary panel is
displayed, your system is not restored to its previous state; the installation
wizard stops immediately. If you want to remove any program that has been
installed, you must use the uninstall program.

When you use the wizard, you might have to wait a few seconds to move to
the next panel after clicking Next >. Progress is not always displayed on all
panels. If you click Next > twice, you might skip an entire panel. To ensure
that the installer is progressing, you can monitor your CPU usage; CPU usage
increases greatly during installation.

Console mode

Console mode presents a character-based interface with which you interact in
a command window. It presents the same options as the graphical interface,
and you can choose values and navigate through the process using the
keyboard only.

Use console mode if you want a command-line rather than a graphical
interface, or if you require additional audible information for
visually-impaired users. When you specify an accessibility option, the
installation wizard generates modified and additional information about its
processing that is more appropriate for screen reader software such as JAWS.

The name of the installation wizard for your operating system is listed in
[“Installation wizard names” on page 72.]

To navigate through the installation, enter the following values:

Move to the next panel

Return to the previous panel

Cancel and terminate the install program
Redisplay the current screen

= o N =
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The default option is always displayed within brackets, for example [1]. If
this default value is your required choice, press Enter to continue.

able 13|shows the options that you can specify in console mode.

Table 13. Console mode options

Command option Command format

Start the installation wizard in console mode. installer -console
Messages are displayed on the console during

installation.

Start the installation wizard in console mode with installer -accessibility

additional audible information for visually-impaired
users. (This option sets the installation automatically
to console mode so you do not need the -console
option as well.)

Silent mode

If you start a silent installation, the installation wizard runs without any
interaction. In this mode, installation is completed with default options, or
according to a predefined set of options, as described below.

Use silent mode with unattended interface for automated installations over a
large number of identical systems.

You cannot install the Message Broker Toolkit directly from CD in silent
mode, because you are required to swap CDs when prompted. Therefore for a
silent mode installation you must either install from DVD, or make a copy of
the CD images on a local or remote drive. For more information about

copying CD images, see [Accessing CDs and DVDs on a remote system” on|

Silent mode does not provide any feedback to the caller, therefore you must
check the installation log to determine if the installation was successful. The
location of the installation log is given in [’Dealing with problems during]|
installation” on page 83| (runtime components) and |“Dealing with problems|
during installation” on page 103| (Message Broker Toolkit).

The name of the installation wizard for your operating system is listed in
[“Installation wizard names” on page 72.|
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You can run a silent installation with default settings, or with one or more
non-default values:

With default settings, the installation wizard performs the following actions:
— Checks that prerequisite software is installed (runtime components only)
— Installs to the default directory

— Installs all selectable features

Because the installation wizard for the runtime components checks for
prerequisite software in silent mode, the program fails if the prerequisite
software is not already installed. You can override this check if you use a
response file (described below), or include the appropriate parameter with a
non-default value on the command invocation.

To run a default silent installation, specify the -silent option on the
installation command. For example, to install runtime components on Linux
(x86 platform), enter the following command:

setuplinuxia32 -silent

With one or more non-default settings, the installation wizard performs the
options that you specify on the command, or reads a response file to
determine what actions to take.

A sample response file is provided in the sample-scripts directory of the
CD or DVD. It includes detailed information about the options that you can
change, and the values that you must enter to change them. You can tailor
this file to your requirements, or you can generate a new response file, as
described below.

To run a tailored silent installation using a response file called
responsel.txt, specify the -silent option and the fully qualified path and
name of the file on the installation command. For example, on Linux (x86
platform), enter the following command:

setuplinuxia32 -silent -options /userl/scripts/responsel.txt

Response files

If you want to install in silent mode, but want to use values other than the
defaults, you can pass a response file to the installation program. A response
file is a text file that contains options that define the choices that the
installation wizard makes.

You can tailor several options in the response file to cause installation to be
completed in a particular way:

Specify a non-default installation location
For runtime components only:
— Choose a custom installation (typical is the default)

Choose which components to install

— Specify if the program is to check for prerequisite software
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You can generate a response file as a template that you can then edit, or you
can record a template while you complete the installation process:

Generating a response file template
To generate a response file template, enter the following command:

installer -options-template responsefile

where installer is the name of the installation wizard on your
operating system (listed in [‘Installation wizard names” on page 72)
and responsefile is the fully qualified path and name of your chosen
response file. On Windows, you must surround the path and name
with double quotes if it contains spaces.

The installation wizard generates a response file template that
contains full instructions on how to edit it to specify your required
options. Installation is not performed.

Editing a response file

If you have generated a response file as shown above, or if you have
taken a copy of the sample file supplied with the product, edit the file
to define the installation that you want to be performed:

* To indicate that non-default options are specified in this file, update
the following line:
# -W setupTypes.selectedSetypTypeld=

Remove the comment character at the start of the line. If you do not
do this, your other options are ignored.

-W setupTypes.selectedSetypTypeld=

* To exclude a component from a typical runtime components
installation, for example, to exclude the Configuration Manager,
find this line in the response file:

# -P configManagerFeature.active=true
Change the line to read:
-P configManagerFeature.active=false

* To suppress prerequisite software checks for the runtime
components, add one or both of the following lines to the file to
instruct the installation wizard to ignore the check for specific
software:

# don't check for WebSphere MQ
-P mgPrerequisite.active=false

# don't check for Java Messaging
-P javaMessagingPrerequisite.active=false
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Recording a response file

To record a response file, enter the following command:
installer -options-record responsefile

where installer is the name of the installation wizard on your
operating system (listed in [‘Installation wizard names” on page 72)
and responsefile is the fully qualified path and name of your response
file. On Windows, you must surround the path and name with double
quotes if it contains spaces. Specify a directory that is different to the
one that you will specify as your installation directory.

The installation wizard starts in graphical mode, and requests your
input as it progresses. Your responses are recorded during installation
and written to the response file. When installation is complete, the
response file contains all the choices that you have made during
installation.

If you want to record a response file during a console mode
installation, enter the following command:

installer -options-record responsefile -console

Before you can use the file, check for the following line:
-W setupTypes.selectedSetupIld=custom

Remove the value custom so that the line has the content shown
below; if you do not, a full installation is completed:

-W setupTypes.selectedSetupld=

You can now use this response file for silent installations on other
computers where you want the same options to be used.

Employing a response file
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When you have created a response file that contains your options,
either by generating and editing a template or a supplied sample, or
by recording your options, you can start the installation wizard and
specify that this file is to be used to determine how the installation is
performed.

To pass a response file to a silent installation, enter the following
command:

installer -options responsefile -silent

where responsefile is the fully qualified path and name of the response
file. On Windows, you must surround the path and name with double
quotes if it contains spaces.
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The following table provides a summary of the options you can use with
response files.

Table 14. Silent mode options

Action Invocation

The installation wizard performs a default installer -silent
installation with no user interaction.

The installation wizard performs an installer -silent -options responsefile
installation with input provided by the
response file.

The installation wizard generates a template |installer -options-template responsefile
response for later modification and use but
performs no installation.

The installation wizard performs an installer -options-record responsefile
installation in graphical mode with user
input, and records all specified options in a
response file.

The installation wizard performs an installer -options-record -console responsefile
installation in console mode with user input,
and records all specified options in a
response file.

Chapter 7. Choosing an installation mode 71



Installation wizard names

Installation wizard names

The installation wizard has a different name on each operating system. To
help you find these programs quickly, the names are shown in the table
below. Substitute this name where you see installer in the text.

Table 15. Installation wizard names

Operating system

Installation wizard name

AIX setupaix
HP-UX setuphp

Linux (POWER setuplinuxppc
platform)

Linux (x86 platform)

setuplinuxia32 (runtime components)
setup.bin (Message Broker Toolkit)

Linux (zSeries setuplinux390

platform)

Solaris (SPARC setupsolaris

platform)

Solaris (x86-64 setupsolarisx86

platform)

Windows setup.exe (runtime components and Message Broker Toolkit)
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Part 3. Installation

The third part of the book describes how you install WebSphere Message
Broker. The information here addresses installation of runtime components on
distributed systems. It also addresses installation of the Message Broker
Toolkit for z/OS and distributed system users.

Chapter 8, “Installing with the Windows Launchpad,” on page 75|

Chapter 9, “Installing runtime components,” on page 85

Chapter 10, “Installing the Message Broker Toolkit,” on page 91|

If you are installing runtime components on z/OS, follow the instructions
provided in the Program Directory for WebSphere Message Broker for z/OS or the
Program Directory for WebSphere Message Broker with Rules and Formatter
Extension for z/OS.
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Chapter 8. Installing with the Windows Launchpad

On Windows, you can use the Launchpad to help you to install WebSphere
Message Broker and its prerequisite products, or to upgrade components to
Version 6.0.0.1 from Version 6.0.0.0.

The Launchpad uses the DVD or CDs to install and upgrade components; you
cannot use the Launchpad if you want to install or upgrade runtime
components or the Message Broker Toolkit from downloaded update packages
from Passport Advantage. Nor can you use the Launchpad to upgrade the
Message Broker Toolkit using the Rational Product Updater (RPU). For these
alternative methods, and their potential advantages, see [Chapter 9, “Installing]
runtime components,” on page 85 or [Chapter 10, “Installing the Message]
Broker Toolkit,” on page 91|

This list summarizes the actions that you must take:

1. Check that you have enough memory and disk space; refer to M
fand disk space” on page 5]

2. Check the readme file readme.html for any updates to these installation
instructions. The readme file location is shown at the start of [Chapter 1,
[‘System requirements,” on page 3

3. Decide whether you want to install from a server, or install locally on each
sistem. These choices are described in [‘Accessing CDs and DVDs” on|

4. Start the Launchpad to install WebSphere Message Broker and the
prerequisite products. Full instructions are provided in
[Windows Launchpad.”|

5. When you have completed installation, see [Part 4, “After installation,” on|
page 105| for information about verifying your installation, and what you

can do next.

6. If you experience problems during installation, refer to

[problems during installation” on page 83)

Starting the Windows Launchpad

When you insert the product media, the Launchpad starts automatically if
autorun is enabled. If autorun is not enabled, find the file mqsilaunchpad.exe
in the root directory of the CD or DVD and double-click, or type
mgsilaunchpad in a command window and press Enter. The Launchpad is
available on every CD from which product components or prerequisite
products might be installed, and on the DVD.
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On the first panel, choose how to install WebSphere Message Broker and any
of its prerequisite products that you have not previously installed:

* Express installation installs a set of products that are required for a
minimum configuration of WebSphere Message Broker. The Launchpad
completes the installation of each product without your input, using default
values where input is required.

Choose this mode if you are not familiar with WebSphere Message Broker,
or its software requirements, or if you want a default installation of the
minimum set of software required for a broker domain configuration.

If you want to perform an Express installation, see [“Express installation” on|

* Advanced installation displays a larger set of required and optional
products that you can install one by one. The Launchpad invokes the
installation program for each product you select in full interactive mode,
and you must provide all required input.

Choose this mode if you are familiar with WebSphere Message Broker and
its software requirements, or if you want to install products individually
and to specify your own values for any options during installation.

If you want to perform an Advanced installation, see

finstallation” on page 81

Access further information from the left pane:

* Click Installation Guide to launch a PDF copy of this book in Acrobat
reader.

¢ Click Readme to view the readme file readme.html in a new browser
window.

¢ Click Quick Tour to take a tour around the product. See |Chapter 11,|
[‘Configuring and verifying your system,” on page 107 for further
information.

The Launchpad might have to search for an installation program for some of
your selections. If you are installing from DVD, all the required products can
be found, but if you are installing from CD, the program might be on another
CD, or might not be in the expected location. If necessary, the Launchpad
prompts you to take the appropriate action to find the file. [Table 16 on page|
shows, for each supplied product, the program names and their locations
on the CDs.
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Table 16. Installation program names and locations

Installation
Product program name Directory CD
WebSphere Eclipse | IBM WebSphere \WebSphere MQ V6.0\Prereqs\IES\MSI Runtime Disk
Platform V3.0 Eclipse Platform 2

V3.0.msi

WebSphere MQ

IBM WebSphere

\WebSphere MQ V6.0\MSI

Runtime Disk

MQ.msi 2
ODBC Drivers for | setup.exe \DB2_Runtime_Client V8.2 Runtime Disk
Cloudscape 1
Message Broker setup.exe \ (root directory) Runtime Disk
runtime 1
components
Message Broker setup.exe \setup Toolkit Disk 1

Toolkit

DB2 Enterprise
Server

DB2 Enterprise
Server Edition.msi

\DB2_Enterprise_Server_V8.2\db2\Windows

Runtime Disk
3

Rational Agent setup.exe \winia32 RAC

Controller supplemental
disk

WebSphere MQ setup.exe \ (root directory) WebSphere

Everyplace MQ
Everyplace
supplemental
disk

Express installation

When the Launchpad starts, it displays the Express installation panel.

1.

Review the minimum set of products required for a default configuration:
* WebSphere Eclipse Platform V3.0.1
* WebSphere MQ V6.0

* ODBC Drivers for Cloudscape

* WebSphere Message Broker V6.0.0.1 (runtime components)

* WebSphere Message Broker Toolkit V6.0.0.1
Check the initial installation status shown for each listed product:

* Required indicates that the product is not installed, and is one of those
required for a minimum configuration.
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* Pending indicates that the product must be installed to ensure the
successful operation of a minimum configuration broker domain. The
associated check box is selected to show that this product will be
installed.

* Installed indicates that the product is already installed at a supported
level. The installed version is shown and no check box is displayed.

* Partial Installation indicates that the product is installed, but not all
components that are required to ensure the successful operation of a
minimum configuration broker domain are present on the system. The
associated check box is selected to show that additional components will
be installed.

* Incorrect Level indicates that an unsupported level of the product is
installed on the system. This product must be upgraded to a supported
level; use the Advanced Installation to complete that task.

Because the ODBC Drivers for Cloudscape are included in DB2
products, you cannot install this component if you have an installation
of DB2 that is at a version prior to 8.2. You are prompted to install DB2
Enterprise Server Version 8.2 from the Advanced panel.

If a previous level of DB2 or WebSphere MQ is installed, you are
directed to run the installation of these products from the Advanced
installation, so that you are presented with the full interactive install
and you can respond to any decisions that must be made during the
upgrade.

If any product is already installed that uses the Rational framework at
Version 6 or above, you are directed to run the installation of the
Message Broker Toolkit from the Advanced installation so that any
potential problems with this installation do not prevent successful
completion of Express installation. For more information about
compatibility with other Rational products, see |Chapter 10, ”Installingl
[the Message Broker Toolkit,” on page 91|

Click the plus sign to the left of each listed product in turn. The
Launchpad displays more information about the product which you can
use to decide if you want it installed. The additional information also
provides an estimate of the time taken to complete each product
installation.

Not all components of each required product are installed during an
Express installation (for example, when the Launchpad installs WebSphere
MQ V6.0, it installs the server, WebSphere MQ Explorer, and the Java
Messaging component). Check the details provided to ensure that an
Express installation will install all the components that you want. If you
want additional components, use the Advanced installation.

WebSphere MQ Explorer requires the WebSphere Eclipse Platform to be
installed; when you select WebSphere MQ V6.0, the Eclipse Platform is
automatically selected.
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The ODBC Drivers for Cloudscape access the default Derby embedded
database, and you can use these for test and evaluation purposes. For
production use, install your chosen enterprise database product. DB2
Enterprise Server Version 8.2 is provided for you to install if this is your
database of choice.

. If you do not want a listed product, clear the check box associated with
the product. Its status is changed to Required, because you cannot
configure and verify your installation without all of the listed products.
However you can complete installation of the remaining products, and
install other required products at a later time.

. Click Launch Express Installation for WebSphere Message Broker.

If you have cleared one or more of the required products, you are asked to
confirm your choices.

The Launchpad installs the products that you have selected in the order
shown, prompting you to insert different CDs, if required. You cannot
make any changes on the Express installation panel after you have started
the installation process. As the Launchpad starts each installation, it
updates status from Pending to In Progress.

* If you have selected WebSphere Eclipse Platform V3.0.1, the Launchpad
starts the installation program in silent mode (default values are used
for all options). A progress bar is displayed so that you can check on
progress.

* If you have selected WebSphere MQ V6.0, the Launchpad starts the
installation program in silent mode (default values are used for all
options). A progress bar is displayed so that you can check on progress.

* If you have selected ODBC Drivers for Cloudscape, the Launchpad
starts the installation program in silent mode (default values are used
for all options). A progress bar is displayed so that you can check on
progress. During installation, you see the product name DB2 Run-Time
Client on the progress bar; this name is also shown in Add/Remove
Programs when the installation is complete.

* If you have selected WebSphere Message Broker V6.0.0.1 (runtime
components), the Launchpad invokes the installation wizard in full
interactive mode. You must supply the input required by the installation
program.

The installation wizard guides you through a series of panels where you
can make choices about where to install the components, and which
components you want to install.

You must also read and accept the Software License Agreement that is
displayed. This agreement also covers your use of both WebSphere MQ
Version 6.0 and the ODBC Drivers for Cloudscape, if you have chosen
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to install one or both of these products. These products are licensed for
use with WebSphere Message Broker only and must not be used for
other purposes.

When you are asked if you want to open a command console when the
wizard terminates, select Yes. A console window opens, initialized with
the correct environment for command invocation. The command console
is explained in [‘Setting the environment for an installation” on page 27)

* If you have selected the Message Broker Toolkit, the Launchpad starts
the installation in full interactive, graphical mode.

The installation program guides you through a series of panels where
you can make choices about where to install the component, and accept
the Software License Agreement that is displayed. You must also decide
whether to install the Language Pack feature. For information about this
selection, see ['The Language Pack feature” on page 18| You must
supply all input required by the installation program.

The wizard checks that any Rational product installed on this system is
compatible; if it is not, the installation of the Message Broker Toolkit
cannot continue. For details of compatibility, see [“Rational Application]
[Developer (RAD)” on page 17} and to resolve this situation, follow the
instructions in [“Integrating with other Rational products” on page 93

When the installation completes, select the check box Start Message
Broker Toolkit if you want to launch the Message Broker Toolkit when
the wizard terminates.

The status of each product changes to Installed when the Launchpad has
completed its installation.

When the Launchpad has installed all your selected products, it returns
control to the Express installation panel.

Click Exit Launchpad to end the program.



Advanced installation

Advanced installation

When the Launchpad starts, it displays the Express installation panel.

1.

Click Advanced Installation in the left panel to display the Advanced
installation panel. The Launchpad displays a list of the following products:

* WebSphere Eclipse Platform V3.0.1

* WebSphere MQ V6.0

* ODBC Drivers for Cloudscape

* WebSphere Message Broker V6.0.0.1 (runtime components)
* WebSphere Message Broker Toolkit V6.0.0.1

* Rational Agent Controller Version 6.0.1

* DB2 Enterprise Server Version 8.2 (Optional)

* Oracle (Optional)

* Sybase (Optional)

* Microsoft SQL Server 2000 (Optional)

Check the initial installation status shown for each listed product:

* If the product is not installed, and is one of those required for a
minimum configuration, the status is Required.

* If the product is not installed, and is an optional product, the status is
Not Installed.

* If the product is already installed, and it is at the supported version (or
later), the status is Installed.

* If an earlier, unsupported, version of the product is installed, the status
is Incorrect Level. You can install the supported version from this panel.

* If a product is found but has not had a complete installation, the status
is Partial Installation. You can install the full product from this panel.

For example, you might previously have completed a typical installation
of WebSphere MQ Version 5.3, which is a supported version. However,
a typical installation does not install the Java Messaging component,
which the broker requires, therefore your installation is shown as
partially complete.

Click the plus sign to the left of a product to expand the information
displayed about the product.

If you want to install this product, and it is an IBM product that is not
already installed, click Install in the expanded information to launch the
product installation.

The Launchpad launches the installation program in full interactive
graphical mode. You must supply the input required by the installation
program, including, if appropriate, which components you want to install.
Start each required installation in the order of your choice. Each
installation is performed separately, and the Launchpad prohibits any
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other action until the current installation has completed. It also minimizes
its window while the installation is in progress, and restores itself to focus
when the installation is complete.

If the Launchpad cannot find an installation program because it is on
another CD, or is not in the expected location, it prompts you to take the
appropriate action to find the file. See [Table 16 on page 77 for details of
installation program names and locations.

When the Launchpad has completed the installation, it updates the
product status to Installed.

If you want to use Oracle, Sybase, or SQL Server, but the product that you
have installed is not at the required supported version, or is not installed,

you must acquire and install the product yourself; the Launchpad does not
provide this option. If Oracle is installed, you must check that the installed
version is supported, because the Launchpad cannot determine the version

of the installed product. Supported databases are shown in [Table 4 on
4. Repeat the previous step for each product that you want to install.

5. When you install WebSphere Message Broker runtime components or the
Message Broker Toolkit, the installation programs guide you through a
series of panels where you can make choices about where to install the
components, and (for runtime component installation only) which
components you want to install. You must also read and accept the
Software License Agreement that is displayed.

During installation of runtime components, you are asked if you want to
open a command console when the wizard terminates. If you do, select
Yes. A console window opens, initialized with the correct environment for
command invocation. The command console is described in
fnvironment for an installation” on page 27

During installation of the Message Broker Toolkit, you must also decide

whether to install the Language Pack feature. For information about this
selection, see [“The Language Pack feature” on page 18] You must supply
all input required by the installation program.

The wizard checks that any Rational product installed on this system is
compatible; if it is not, the installation of the Message Broker Toolkit
cannot continue. For details of compatibility, see [“Rational Application|
[Developer (RAD)” on page 17,|and to resolve this situation, follow the
instructions in |“Integrating with other Rational products” on page 93)

If you want to launch the Message Broker Toolkit when its installation
wizard has completed, select the check box Start Message Broker Toolkit.

6. When an installation has completed, and before you start another
installation, you can click Refresh Advanced Installation List to check the
status of each product listed.
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7. When you have completed installation of all your chosen products, click
Exit Launchpad to end the program.

Dealing with problems during installation

The Launchpad waits for a return code from each installation program it
initiates. If the return code indicates that the installation has failed, the
Launchpad reports the error and refers you to the documentation for the
product that has failed. Most installation programs roll back from the point of
the error and return your system to the state it was in before the failed
attempt, and you can therefore try again after you have corrected the error.

If the Launchpad has already installed one or more products successfully
before an error occurred, it does not roll back these installations. When you
restart the Launchpad, the status of installed products reflects successful
installations from the previous invocation.

If a failure occurs:

* If you have chosen an Express installation, you must either correct the error
and restart the Launchpad, or return to the Express installation panel and
clear the selection of the product that failed.

* If you have chosen an Advanced installation, you can continue to install
other products and address any reported errors at a later time.

If you are unable to install any of the products:

* Refer to the readme file readme.html for any late changes to the installation
instructions.

* If Message Broker runtime components fail to install, check the contents of
the installation log mgsi6_install.log, stored in your home directory.

* If the Message Broker Toolkit fails to install, check the contents of the
installation log wmbt_install.Tlog, stored in the install_dir\logs directory.

* If WebSphere MQ fails to install, check the contents of
MQV6_install.date_time.log stored in the temp directory of your home
directory.

 If DB2 fails to install, check the contents of db2diag.log and other logs
created during installation of this product. For details of location and
possible content, see the DB2 documentation.

+ Review the problem scenarios described in{Appendix A, “Installation|
[problems,” on page 121|and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.
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Chapter 9. Installing runtime components

This chapter describes the tasks that you must complete to install one or more
runtime components, or to upgrade one or more components from Version
6.0.0.0 to Version 6.0.0.1, on the following systems:

+ AIX

+ HP-UX

* Linux (POWER platform) (new installations only)

* Linux (x86 platform)

e Linux (zSeries platform)

* Solaris (SPARC platform)

¢ Solaris (x86-64 platform) (new installations only)

* Windows

If you want to install only the Message Broker Toolkit, see [Chapter 10}
[“Installing the Message Broker Toolkit,” on page 91)

This list summarizes the actions that you must take:

1. Check that you have enough memory and disk space; refer to
land disk space” on page 5/

2. Check the readme file readme.html for any updates to these installation
instructions. The readme file location is shown at the start of [Chapter 1,
[‘System requirements,” on page 3.|

3. (New installations only) If you do not already have WebSphere MQ
installed, install it before you install the runtime components.

Although you can install WebSphere MQ after you have installed runtime
components, the installation wizard checks that you have WebSphere MQ
Version 5.3.0.1 or later installed. If this check fails in graphical or console
mode, the installation wizard displays a warning that lists potential
problems. If you choose to continue, you must complete installation of
WebSphere MQ before you create or start any WebSphere Message Broker
runtime components.

If the check for WebSphere MQ fails in silent mode, and you have not
modified the default behavior by specifying a tailored response file, the
wizard terminates without taking any further action. If you have modified
the response file to ignore this check, the installation wizard continues.
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4. Decide if you want to install from a server, or install locally on each
system. These choices are described in [“Accessing CDs and DVDs” on|
for both CDs or DVDs, and images that you have downloaded
from Passport Advantage (if you are registered with the scheme). The
instructions here do not differentiate between CDs and downloaded
images; their behavior is the same.

5. Decide which mode of installation you want to use. The alternatives are
explained in [Chapter 7, “Choosing an installation mode,” on page 65]

6. Follow the installation instructions provided in [“Installing in graphicall
mode” on page 87 |[“Installing in console mode” on page 88,|or [‘Installing]
in silent mode” on page 89|

When you start the installation wizard, it checks your system locale
setting. If the locale setting is supported (listed in [Chapter 3, “Nationall
[language support,” on page 31)), the wizard continues in this locale. If the
current setting is not supported, the wizard displays a dialog box, and you
must choose from the list of supported languages. This language is used
for installation only, and does not affect other processes on your computer.

If you are installing a broker, a database is required. The installation
wizard completes even if a supported database is not present on this
system, but you must install one before you can use the broker. For further
information about software requirements, see [“Software requirements” on|

7. When you have completed installation, see |Part 4, “ After installation,” on|
for information about verifying your installation, and what you
can do next.

If you install one or more runtime components on Windows, the Start
menu is updated. Detailed updates are described in[“Menu updates” on|

page 125.
8. If you experience problems during installation, refer to

[problems during installation” on page 89)
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Installing in graphical mode
To install in graphical mode:
1. Start the installation wizard in graphical mode:
* For local access, load the product CD or DVD.

Windows

— If autorun is enabled, the Launchpad is started immediately.
To use the Launchpad, see|Chapter 8, “Installing with the]
[Windows Launchpad,” on page 75/ To cancel the Launchpad,
click Exit Launchpad.

— In Windows Explorer, navigate to the root directory of the
CD. Locate the wizard: its name is defined in |[“Installation
[wizard names” on page 72.|Double-click the wizard to start
it.

— Open a command prompt and navigate to the root directory

of the CD. Type the program name with no options, and
press Enter.

Linux Open a command prompt and navigate to the root directory of
the CD. Type the program name with no options, and press
Enter.

¢ For remote access, access the remote CD drive or network drive on
which the product media is available. Find the program file that you
want on the CD or mapped drive and start it as described above.

2. When the wizard starts, navigate through the pages and provide input
when requested. For example, you are asked to specify where to install the
components, and which components you want to install. You must also
read and accept the Software License Agreement.

If you have an existing Version 6.0.0.0 installation, you can upgrade it to
Version 6.0.0.1, or you can request a custom installation and install Version
6.0.0.1 in a different location.

3. When the summary page is displayed, check your choices and click Next
to complete installation. A progress bar is displayed so that you can check
on progress.
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Installing in console mode

To install in console mode:

1.

Locate the installation wizard in the root directory of the local CD or
remote CD or network drive. The wizard name for your operating system
is listed in [“Installation wizard names” on page 72|

Enter the following command at a command prompt for default
invocation.

If you start the installation from a directory other than the one in which
the wizard exists, include the absolute or relative path with the command
name.

installer -console

You can specify other options when you start the wizard; these are
described in [“Console mode” on page 66.|For example, for improved
accessibility, enter the following command:

installer -accessibility

When the wizard starts, follow the prompts given and provide input when
requested. For example, you are asked to specify where to install the
components, and which components you want to install. You must also
read and accept the Software License Agreement that is displayed.

If you have an existing Version 6.0.0.0 installation, you can upgrade it to
Version 6.0.0.1, or you can request a custom installation and install Version
6.0.0.1 in a different location.

Check and confirm your choices when asked to do so, and enter 1 to
complete installation.

If you are installing a broker, a database is required. The installation wizard
completes even if a supported database is not present in this system, but you
must install one before you can use the broker. For further information about
database requirements, see [Databases” on page 9.
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Installing in silent mode

To install in silent mode:

1.

Locate the installation wizard in the setup directory of the local CD or
DVD or remote CD or network drive. The wizard name for your operating
system is listed in [“Installation wizard names” on page 72.|

Enter the following command at a command prompt for a typical
installation with all default settings.

If you start the installation from a directory other than the one in which
the wizard exists, include the absolute or relative path with the command
name.

Linux and UNIX
installer -silent

Windows Start the installation wizard within a start command with
parameter /w to ensure that the installation completes
before it returns to the command prompt:

start /w setup.exe -silent

If you want to specify non-default settings, include a response file on the
invocation. You would need a response file, for example, if you have an
existing Version 6.0.0.0 installation and want to specify a custom
installation to install Version 6.0.0.1 in a different location.

For more details of how to use response files, how to create response files,
and how to edit them to define your requirements, see [‘Response files” on|

The installation wizard completes without any user interaction.

Dealing with problems during installation

If you have problems during installation:

Refer to the readme file readme.html for any late changes to the installation
instructions.

Check the contents of the installation log mqsi6_install.log, stored in your
home directory.

Review the problem scenarios described in{Appendix A, “Installation|
[problems,” on page 121|and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.
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Chapter 10. Installing the Message Broker Toolkit

This chapter describes the tasks that you must complete to install the Message
Broker Toolkit, or to upgrade the Message Broker Toolkit from Version 6.0.0.0
to Version 6.0.0.1, on the following systems:

¢ Linux (x86 platform) (excluding Red Hat Enterprise Advanced Server V4)

* Windows

It also describes how you can upgrade existing Version 6.0.0.0. installations of
the Event Broker Toolkit Version 6.0.0.0 to Message Broker Toolkit Version
6.0.0.1.

Instructions for adding the Language Pack feature after installation are also
provided.

If you want to install only runtime components, see [Chapter 9, “Installing|
fruntime components,” on page 85

This list summarizes the actions that you must take:

1. Check the readme file readme.html for any updates to these installation
instructions. The readme file location is shown at the start of [Chapter 1,
[‘System requirements,” on page 3.|

2. Check that you have enough memory and disk space; refer to
fand disk space” on page 5/

If you do not have enough temporary space in your default temporary
directory, you can specify a different temporary directory when you start
the installation. See [‘Changing the location of the temporary space]
(directory” on page 102| for details.

3. If Message Broker Toolkit Version 6.0.0.0 is installed on this system, and
you want to upgrade it to Version 6.0.0.1, decide if you want to use the
Rational Product Updater (RPU), or if you want to install from CD, DVD,
or images that you have downloaded from Passport Advantage (if you are
registered with the scheme):

* If you want to install from CD, DVD, or downloaded images, continue
with step The instructions do not differentiate between
CDs, DVDs, and downloaded images; their behavior is the same.

* If you want to use the Rational Product Updater (RPU), follow the
instructions in [“Upgrading the Message Broker Toolkit to Version|
[6.0.0.1” on page 94,then continue with step |6 on page 9§|
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4. If Event Broker Toolkit Version 6.0.0.0 is installed on this system, and you

want to upgrade it to Message Broker Toolkit Version 6.0.0.1, follow the
instructions in [“Upgrading the Event Broker Toolkit Version 6.0.0.0 to|

[Message Broker Toolkit Version 6.0.0.1” on page 98 |then continue with
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step [6 on page 93]

If you have never installed the Message Broker Toolkit on this system, or if
you have chosen to upgrade your installation from local or remote images:

a. Decide whether you want to install from a server, or install locally on

each system. These choices are described in [“Accessing CDs and|
[DVDs” on page 51)

. Check that the installation of the Message Broker Toolkit is compatible

with other Rational products installed on the target system.

If you need further information about Rational compatibility, see
[“Rational Application Developer (RAD)” on page 17 Check whether to
install the Language Pack feature when you install Message Broker
Toolkit; the choice is discussed in the same section.

If your system has other Rational products installed, and they are not
compatible, follow the instructions in [‘Integrating with other Rationall
[products” on page 93| before you install the Message Broker Toolkit.

. Decide which mode of installation you want to use. The alternatives

are explained in |[Chapter 7, “Choosing an installation mode,” on page]

. Follow the installation instructions provided in [“Installing from CD or|

[DVD” on page 98]
If you install the Message Broker Toolkit from CD on Linux (x86
platform), invoke the wizard from a location other than the mount
point itself. If you do not do so, you cannot change CDs because the
CD drive is locked. For example, if your mount point is /media/dvd/,
invoke the wizard from another location with the following command:

/media/dvd/setup/setup.bin

When you start the installation wizard, it checks your system locale
setting. If the locale setting is supported (listed in [Chapter 3, “Nationall
[language support,” on page 31), the wizard continues in this locale. If
the current setting is not supported, the wizard displays a dialog box,
and you must choose from the list of supported languages. This
language is used for installation only, and does not affect other
processes on your computer.
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6. When you have completed installation, see [Part 4, “After installation,” on]
for information about verifying your installation, and what you
can do next.

When you install the Message Broker Toolkit on Windows, the Start menu
is updated. When you install the Message Broker Toolkit on Linux (x86
platform), the main menu is updated. Detailed updates are described in
["Menu updates” on page 125

7. If you experience problems during installation, refer to

[problems during installation” on page 103

Integrating with other Rational products

If you want to install the Message Broker Toolkit on a system on which an
incompatible Rational product exists, the existing product could be at a higher
level, or a lower level. For example, RAD and RSA products cannot be below
Version 6.0.1.1 and must be below Version 6.0.2. For more information about

compatible Rational levels, see ['Rational Application Developer (RAD)” onl|

If a Rational product is at a lower level
If you start the installation of the Message Broker Toolkit and the
wizard detects an earlier incompatible version of a Rational product
already on this system, the wizard tells you that you must run the
Rational Product Updater (RPU) to upgrade your existing installation
to a compatible fix level. The wizard cannot continue.

You must complete one of the following two options before you can
install the Message Broker Toolkit:

1. Upgrade the existing product installation using the RPU. Click
Help > Software Updates > IBM Rational Product Updater to
access and apply the product updates. The RPU displays all
available updates for the installed Rational products.

Search for the latest updates for the installed product. For
example, for RAD, search for Version 6.0.1.1 or a later compatible
fix level. Select a compatible update and follow the instructions to
install it.

2. Remove the existing Rational product installation. Use the
appropriate uninstall program to complete this task.

If a Rational product is at a higher level
You must remove the existing product installation before you can
install Message Broker Toolkit on this system. Use the appropriate
uninstall program to complete this task.
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Upgrading the Message Broker Toolkit to Version 6.0.0.1

If you have installed the Message Broker Toolkit Version 6.0.0.0 (General
Availability September 2005), you can upgrade it to Version 6.0.0.1 in one of
three ways:

* Use the Rational Product Updater. You can use this method in two ways:

— Install the RPU packages from the Web.

This method is the most convenient for a single system. However, you
might be affected by network delays, and if your connection is
interrupted during the update, you have to start again from the
beginning.

If you choose this option, follow the instructions in [“Installing RPUJ
[packages directly from the Web” on page 95|

— Install the RPU packages from a local system.

Download the RPU packages from the Web to a local device, for example
a network drive, and access the local copy to update each system on
which you have installed the toolkit. This option has the following
advantages:

- A single user can download the update packages, and therefore only
one user and one system require Internet access.

- Multiple installations of the toolkit in your network can access the
downloaded image on a local system.

- Connections within your network are typically quicker and more
reliable than connections to the Internet.

If you choose this option, follow the instructions in [“Installing RPU|
[packages from a local system” on page 96.|

¢ Use the Version 6.0.0.1 CDs or DVD. The new version installs over the

existing version.

You might prefer this option because it is more familiar, or, on Windows,
because you can use the Launchpad to control the installation process. If
you set up a remote server, users on different systems can access the same
images. You could also create a tailored response file so that all your users
can complete a silent installation.

If you choose this option, follow the instructions in [“Installing from CD o]
[DVD” on page 98

Use the download images from Passport Advantage, if appropriate. The
new version installs over the existing version.

If you set up a remote server, users on different systems can access the
same images. You could also create a tailored response file so that all your
users can complete a silent installation.
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If you choose this option, follow the instructions in [“Installing from CD oy
[DVD” on page 98] The behavior of a downloaded image is the same as for
a local or remote CD image.

You can start the RPU from the main menu (on Linux (x86 platform)) or Start
menu (on Windows), or from the command line:

Linux (x86 platform)

You must have root authority to run the RPU.

If you are logged in as root, use the main menu to start the RPU:

* On Red Hat Linux (x86 platform) (GNOME desktop environment),
select Programming > Rational Product Updater. If your desktop
environment is not the default, this shortcut might appear in
another location.

* On SUSE Linux (x86 platform) (K Desktop Environment), select
IBM WebSphere Message Brokers 6.0 > Rational Product Updater.
If your desktop environment is not the default, this shortcut might
appear in another location.

If you are logged in as another user and have become root, you must
use the command line. Run the file rpu in directory
install dir/updater/eclipse/.

Windows

You must have Administrator authority to run the RPU.

Select Start > Programs > IBM WebSphere Message Brokers 6.0 >
Rational Product Updater.

To start the RPU from the command line, run the file rpu.exe in
directory install_dir\updater\eclipse\.

Installing RPU packages directly from the Web
To install the RPU packages directly from the Web:

1.

2.

3.

If you have an active Message Brokers Toolkit session, close it. You cannot
apply updates while the toolkit is running.

Start the RPU from the Start or main menu or from the command line; the
RPU opens in a new window.

Check that your RPU update site is set to point to the update Web site, not
to a local site; select Preferences > Update Sites and click Restore Default
to address the correct Web site.

If the RPU program itself requires an update, a message is displayed, and
you must install that update before you can install any other updates. The
RPU must be at Version 6.0.1 to complete these updates. When it has
installed the update, the RPU restarts itself.
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9.

If you have previously disabled any product features by editing the
feature.xml files or selecting Help > Software Updates > Manage
Configuration, you must enable the features before you can continue.

Check the list of Rational products that you currently have installed; the
RPU presents the list in the Installed Products pane.

Click Find Updates. The RPU searches for all updates for the selected
product and displays them in the Updates pane. This action might take a
few minutes to complete, depending on network traffic and connection
speeds.

All items are selected by default; clear any selections that you do not want
to install at this time. For the upgrade of the Message Brokers Toolkit, you
must install both IBM WebSphere Message Brokers Toolkit Version
6.0.0.1 and J2EE Connector Tools Version 6.0.1.2.

Click Install Updates and follow the instructions that are given. The RPU
installs the Message Brokers Toolkit update, followed by the J2EE
Connector Tools. If you choose to update these two packages separately,
you must install them in this order; the J2EE Connector Tools update will
not install unless the Message Brokers Toolkit package is already installed.

When the updates have been installed, close the RPU.

Installing RPU packages from a local system
To install updates from downloaded RPU packages, you must first download

the

packages, then change the RPU settings to access the downloaded package

on each system on which you want to install the updates.

To download the update packages:

1.
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Access the [[BM Support site at:
http://www.ibm.com/software/integration/wbhimessagebroker/support/

First check if an update to the RPU itself is required. The RPU must be at
Version 6.0.1 or later. If your systems are not at this level, download this
update and make sure that users who install from the local system install
this update first.

a. In the section with the heading Other support sites, click the Rational
link.

b. Under Support for specific Rational products, click Rational
Application Developer for WebSphere software.

c. Under Download, click View all downloads, then find and click
Rational Product Updater 6.0.1. The page that opens describes the
update, and gives access to the update package and to detailed
installation instructions.

d. Click the FTP link to download and save the update package
rpu_601.zip to a local drive. To complete the download, you must
accept the terms and conditions.


http://www.ibm.com/software/integration/wbimessagebroker/support/
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3. Return to the WebSphere Message Broker support page to access the

update packages:

a. In the section with the heading Download, click Recommended
Updates.

b. Click the link for IBM WebSphere Message Broker Version 6.0.

c. Find the Message Brokers Toolkit Version 6.0.0.1 update. This package
includes the corequisite J2EE Connector Tools update that must be
installed at the same time.

d. Click the Download option, and click Save to save the file to disk.

e. Enter the directory in which you want to save the file. The file name is
MB60_6001.z1ip; you can keep this name or choose a different one.

f. Click Save. The file is downloaded to your system. This action might
take a few minutes, depending on network traffic and the speed of
your connection.

Extract the files from the compressed update files using your chosen
extraction program. You can extract the files to the directory in which the
compressed file is stored, or you can specify a different directory or
different device, or both, if you prefer. Extract files from each download
file into its own directory, because each package includes a file named
policy.xml which defines the content of the update package and must not
be overwritten.

If necessary, authorize users to access the location of the extracted files.
For example, on Windows you might have to change the properties of the
disk or folder so that other users can share it. On Linux (x86 platform),
you can use the exportfs command.

To install the packages from the local system:

1.

If you have an active Message Brokers Toolkit session, close it. You cannot
apply updates while the toolkit is running.

Start the RPU from the Start or main menu, or from the command line;
the RPU opens in a new window. A list of the Rational products that you
currently have installed is displayed in the Installed Products pane.

Select Preferences > Update Sites. The dialog box asks for the path or
URL of a new policy file. If an update is required to the RPU itself, you
must install this first. Click Browse to find the policy.xml file in the
directory for the update package, or type the path and file name into the
entry field, supplying the location given to you by the person who created
the local packages. Click OK.

Click Find Updates. The RPU displays the available update, as defined by
the policy.xml file, in the Updates pane.

Select the displayed item, click Install Updates, and follow the instructions
given.
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Repeat steps [3 on page 97}|4 on page 97} and |5 on page 97 for the Message
Brokers Toolkit update package after you have installed the update to the
RPU (if required).

When you have installed all the required updates, close the RPU.

Upgrading the Event Broker Toolkit Version 6.0.0.0 to Message Broker Toolkit

Version 6.0.0.1

If you have installed the Event Broker Toolkit Version 6.0.0.0 (General
Availability September 2005), and have now purchased WebSphere Message
Broker, which includes Message Broker Toolkit Version 6.0.0.1, you can
upgrade your toolkit installation without uninstalling and reinstalling.

Complete the following steps in the order shown. Use the same Language
Pack feature option as you did for your original installation at each step.

1.

Upgrade the Event Broker Toolkit Version 6.0.0.0 to Event Broker Version
6.0.0.1. You must complete this step using the Rational Product Updater:

* To upgrade directly from the Web, follow the instructions given in
[“Installing RPU packages directly from the Web” on page 95/

* To upgrade from a local copy of the upgrade packages, follow the
instructions given in [“Installing RPU packages from a local system” onl|
substituting file name EB60_6001.zip as the name of the
package to download.

For further details about the advantages of each option, and for
information about how to start the RPU, read |[“Upgrading the Messagé]
[Broker Toolkit to Version 6.0.0.1” on page 94/

Upgrade the Event Broker Toolkit Version 6.0.0.1 to Message Broker
Toolkit Version 6.0.0.1. You must use the Message Broker Toolkit CDs to
complete this step. Follow the instructions in [“Installing from CD or]

Installing from CD or DVD

Install the Message Broker Toolkit in your chosen installation mode:

‘Installing in graphical mode” on page 99|

‘Installing in console mode” on page 100)

‘Installing in silent mode” on page 100

Use these instructions for installing from download images as well as CDs or
DVDs; the behavior is the same.
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Installing in graphical mode
To install in graphical mode:
1. Start the installation wizard in graphical mode:
* For local access, load the product CD or DVD.

Windows

— If autorun is enabled, the Launchpad is immediately started.
To use the Launchpad, see[Chapter 8, “Installing with the|
[Windows Launchpad,” on page 75]To cancel the Launchpad,
click Exit Launchpad.

— In Windows Explorer, navigate to the root directory of the
CD. Locate the wizard: its name is defined in [“Installation
wizard names” on page 72.|Double-click the wizard to start
it.

— Open a command prompt and navigate to the root directory

of the CD. Type the program name with no options, and
press Enter.

Linux Open a command prompt and navigate to the root directory of
the CD. Type the program name with no options, and press
Enter.

If you want to change the temporary space location, use a
command-line invocation and specify the appropriate options, as
described in|“Changing the location of the temporary space directory”]
|0n page 102,

¢ For remote access, access the remote CD drive or network drive on
which the product media is available. Find the program file that you
want on the CD or mapped drive, and invoke it as described above. If
you want to change the temporary space location, use a command-line
invocation and specify the appropriate options, as described in
[“Changing the location of the temporary space directory” on page 102

2. When the wizard starts, navigate through the pages and provide input
when requested. For example, you are asked to specify where to install the
Message Broker Toolkit. You must decide whether you want to install the
Language Pack feature; for guidance on this decision, see
[Pack feature” on page 18]If you are upgrading from Version 6.0.0.0 to
Version 6.0.0.1, or from Event Broker 6.0.0.1 to Message Broker 6.0.0.1,
make the same choice as you did when you installed Version 6.0.0.0.

You must also read and accept the Software License Agreement that is
displayed.

3. When the summary page is displayed, check your choices and click Next
to complete installation. A progress bar is displayed so that you can check
on progress.
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4. On Windows only, when installation is complete, select the check box Start

Message Broker Toolkit if you want to launch the Message Broker Toolkit
when the wizard terminates. This option is not available on Linux (x86
platform), because you might want to complete verification logged on as a
different user ID without root authority.

Installing in console mode
To install in console mode:

1.

Locate the installation wizard in the root directory of the local CD or
remote CD or network drive. The wizard name for your operating system
is listed in [“Installation wizard names” on page 72|

Enter the following command for default invocation. If you start the
installation from a directory other than the one in which the wizard exists,
include the absolute or relative path with the command name.

installer -console

If you want to change the temporary space location, specify the
appropriate options, as described in[“Changing the location of the]
[femporary space directory” on page 102] For details of other options you
can specify, see|’Console mode” on page 66 For example, for improved
accessibility, enter the following command:

installer -accessibility

When the wizard starts, follow the prompts given and provide input when
requested. For example, you are asked to specify where to install the
Message Broker Toolkit. You must decide whether you want to install the
Language Pack feature; for guidance on this decision, see
[Pack feature” on page 18/If you are upgrading from Version 6.0.0.0 to
Version 6.0.0.1, or from Event Broker 6.0.0.1 to Message Broker 6.0.0.1,
make the same choice as you did when you installed Version 6.0.0.0.

You must also read and accept the Software License Agreement that is
displayed.

Check and confirm your choices when asked to do so, and enter 1 to
complete installation.

On Windows only, when installation is complete, select the option if you
want to launch the Message Broker Toolkit when the wizard terminates.
This option is not available on Linux (x86 platform), because you might
want to complete verification logged on as a different user ID without root
authority.

Installing in silent mode
To install in silent mode:

1.

Locate the installation wizard in the setup directory of the local CD or
DVD or remote CD or network drive. The wizard name for your operating
system is listed in [“Installation wizard names” on page 72,
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2. Enter the following command at a command prompt for a typical

installation with all default settings. If you start the installation from a
directory other than the one in which the wizard exists, include the
absolute or relative path with the command name.

Linux (x86 platform)
setup.bin -silent

Windows Start the installation wizard within a start command with
parameter /w to ensure that the installation completes
before it returns to the command prompt:

start /w setup.exe -silent

If you want to change the temporary space location, specify the
appropriate options on the command, as described in [“Changing the|

[location of the temporary space directory” on page 102

If you want to specify non-default settings, include a response file on the
invocation. For more details of how to use response files, how to create
response files, and how to edit them to define your requirements, see
[‘Response files” on page 68.|

You can modify the following options:

-P installLocation="fullpath"

-P feature_lang_pack_wmbt_win32.active=true

installlLocation specifies a non-default location into which the Message
Broker Toolkit is installed. Enclose the specified path in quotes, and
specify a fully qualified path, not a relative path.

feature_Tang pack wmbt win32.active indicates (on Windows in this
example) that the Language Pack feature is to be installed; for guidance on
this decision, see [‘The Language Pack feature” on page 18,Set this option
to false if you do not want the feature installed. If you are upgrading
from Version 6.0.0.0 to Version 6.0.0.1, or from Event Broker 6.0.0.1 to
Message Broker 6.0.0.1, make the same choice as you did when you
installed Version 6.0.0.0.

Adding the Language Pack feature after installation

If you have installed, or upgraded, the Message Broker Toolkit without
selecting the Language Pack feature, you can decide to add this feature later.
To do so, you must reinstall the component, and you must run the Rational
Product Updater to resolve dependencies.

1.

Run the installation wizard again for your installation at Version 6.0.0.1.
You must use the CDs or DVD to complete this step, and you must
complete the full installation process. Select the Language Pack feature
when it is offered.
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This step generates the following errors:

* In the RAD log run_wmbt_rad_update_errout.log:
Component feature "updater.j2c.n1l.plugins.601" not found

* In the J2C log run_wmbt_j2c_update_errout.log:
Component feature "updater.csdev.n1l.plugins.601" not found

You can safely ignore these errors and continue with step 2, which
resolves the missing features.

2. Access the Version 6.0.0.1 RPU update package to resolve dependencies.
Use one of the following two methods:

 Start the RPU and access the update site directly: select Preferences >
Update Sites and click Restore Defaults to ensure you are addressing
the right site. When the RPU determines the Rational products on your
system, it completes the resolution of dependencies required by the
addition of the Language Pack feature.

* Download the update package MB60 6001.zip to a local system (as
described in [“Installing RPU packages from a local system” on page 96).
Start the RPU and address the local package policy.xml file. When it
accesses this file to determine the updates available, the RPU resolves
the dependencies required by the addition of the Language Pack feature.

Changing the location of the temporary space directory

102

When you install the Message Broker Toolkit, temporary space of 1.9 GB is
required. If it is not available, the installation program fails.

By default, the installation program uses /tmp on Linux (x86 platform) and the
directory pointed to by the system variable TEMP on Windows. You can change
this default value, for this installation only, by including options when you
invoke the installation program from the command line.

Type -is:tempdir new_temp_dir_location to identify the new fully-qualified
directory. On Windows, if the new temporary directory or path includes a
space, specify double quotes around the new name.

For example, enter the following command to start the installation wizard in
graphical mode and specify a different temporary directory to use:

Linux
./setup.bin -is:tempdir /mgsi_temp_space

Windows
setup.exe -is:tempdir C:\mgsi\temp_space
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Dealing with problems during installation

If you have problems during installation:

* Refer to the readme file readme.html for any late changes to the installation
instructions.

¢ Check the contents of the installation log wmbt_install.log, stored in the
install_dir\logs directory. Messages written to this file can help you to
understand installation failures.

* If you have upgraded the toolkit to Version 6.0.0.1 using the RPU, check the
contents of the RPU log run_wmbt_rad_update_errout.log, stored in the
install_dir\logs directory. Messages written to this file can help you to
understand failures encountered by the RPU.

For example, if you have tried to install the Language Pack feature, but a
previous Rational product was installed without the Language Pack feature,
you might see a message in the log similar to the following message:

Component feature "updater.crystal.nll.plugins.6011" not found

This log might also report out of disk space errors; see [Table 2 on page 6| for
space requirements, and [Appendix A, “Installation problems,” on page 121
for further guidance.

* Review the problem scenarios described in{Appendix A, “Installation|
[problems,” on page 121|and follow the guidance given.

If you are still unable to resolve the problem, contact your IBM Support
Center.
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Part 4. After installation

This part of the book discusses what to do after installation:
Linux (x86 platform) and Windows

If you have installed all the runtime components and the Message
Broker Toolkit component on your Linux (x86 platform) or Windows
system, follow the verification procedures described in |[Chapter 11,
[“Configuring and verifying your system,” on page 107.

The verification procedures are limited to these operating systems
because they exploit wizards and sample programs that are available
when you launch the Message Brokers Toolkit. The samples require
that all WebSphere Message Broker components are installed on the
same system.

In addition, a database is required for the broker:
* On Linux (x86 platform), install DB2 Enterprise Server.

* On Windows, install either ODBC Drivers for Cloudscape to use the
Derby database, or DB2 Enterprise Server.

No specific verification programs are provided on other operating
systems.

All distributed systems and z/OS
Launch the Message Brokers Toolkit on your chosen operating system
and explore the resources that are provided to help you learn about
the product, and how you can use it on all operating systems.
(Chapter 12, “What’s next,” on page 115|provides details about how to
access the Welcome page resources and the information center.
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Chapter 11. Configuring and verifying your system

This chapter describes how to verify your installation on Linux (x86 platform)
and Windows.

If you have installed only runtime components on other operating systems, or
you have installed an incomplete set of components on Linux (x86 platform)
or Windows, see the guidance provided in [Chapter 12, “What’s next,” on page

Getting started

When you have completed installation:
1. Launch the Message Brokers Toolkit:

* On Linux (x86 platform), you do not need root authority to complete
verification. It is for this reason that you cannot launch the Message
Brokers Toolkit from the installation wizard; you might experience
problems if you create resources such as brokers if you are logged in as
root.

Log off from the user ID with which you have installed the product.
Log in as the same ID (if this is not root), or log in as another ID, but
do not become root. Launch the Message Brokers Toolkit from the main
menu or start the program wmbt.bin located within the installation
directory.

* On Windows, you do need Administrator authority to complete
verification. It is therefore appropriate to complete verification with the
same user ID that you used to complete installation. If you did not
launch the Message Brokers Toolkit from the installation wizard, launch
it from the Start menu or start the program wmbt.exe located within the
installation directory.

2. When you first launch the Message Brokers Toolkit, you are asked to
specify the location of your workspace. This file exists on your local drive,
and is where the Message Brokers Toolkit stores all the resources that you
create. You can accept the default path and file name shown, or you can
specify your own choice by typing it in, or by locating it using the Browse
button. Select the check box Use this as the default and do not ask again
to inhibit the display of the workspace dialog next time you launch the
Message Brokers Toolkit.

The Message Brokers Toolkit opens and the Welcome page is displayed.
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3. Hover your cursor over the icons on the Welcome page to see what each
one describes. The choices displayed on the Welcome page on Linux (x86
platform) and Windows are identical

SR SRC ORI

Figure 3. The Welcome page choices (Windows)

4. Click the Getting Started icon @ to begin the configuration and
verification process.

Getting Started creates a default configuration that is used by a sample
program to verify that your installation is successful. For more

information, see|“Creating the default configuration” on page 109]and
‘Running the Pager samples” on page 111.

Getting Started requires the following conditions to be met:

* You have installed all runtime components and the Message Brokers
Toolkit.

* On Linux (x86 platform), you have installed DB2 Enterprise Server, and
you have run the DB2 profile for your current user ID, for example:
. ~db2instl/sql1ib/db2profile
where db2instl is the user ID of the DB2 instance owner (db2inst1 is
the default name; substitute the name that is in use on this system).

* On Windows, you have installed either the ODBC Drivers for
Cloudscape, or DB2 Enterprise Server.

* None of the default components already exists (the components are
listed in [“Creating the default configuration” on page 109).

* This configuration is required for test and evaluation purposes only.
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* Your current user ID has the following characteristics:
— It is a member of groups mgbrkrs and mgm.
— It has Administrator authority (Windows only).
— Itis a local ID, not a domain ID (Windows only).
— It is authorized to create a database for the broker:
- On Linux, add your user ID to the DB2 instance manager owner
group.
- On Windows, add your user ID to the DB2 administrator group.

For more information about these security requirements, see|’Setting up|
[security” on page 47|

You cannot complete the configuration and verification described here if
these conditions are not met.

Creating the default configuration

Before you can run any sample programs, create a set of components within a
broker domain. You can complete this task using the Default Configuration
wizard, which creates the components that you need with fixed names and
properties.

1. Click the Create the Default Configuration text (Linux) or icon (Windows)

b on the Getting Started page. The "Creating the Default
Configuration” page opens.

2. Click Start the Default Configuration wizard. The Default Configuration
wizard starts.

3. Follow the guidance provided by the wizard to navigate through its pages.

The wizard creates a default configuration that can be used by a sample
program to verify that your installation is successful. (Ignore the option to
enable a publish/subscribe broker within the domain. Publish/subscribe
enablement is not required by the sample that you run to verify your
installation. After verification, refer to the information center to find out
about publish/subscribe.)

The wizard displays a progress bar that shows which task it is currently
performing. It also reports on all the actions that it takes by writing
progress information into a scrollable text window from which you can
copy and paste some or all of the information displayed.

The information in the text window is also written to the following log
file:

install _dir/eclipse/workspace/defaultConfiguration.log

If the wizard encounters an error in processing, it informs you of what has
happened and returns any error information, for example a return code
from a command. If you know why the error has occurred from the error
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text, and can correct the situation, you can do so now. Return to the error
message display and click Yes to continue the wizard.

If you do not understand the error, and do not know how to fix it, click
No. The wizard rolls back all the actions that it has taken so far, if it can,
so that when it completes, your system is in the same state as it was in
before you started the wizard. The text window shows you exactly what
the wizard has, and has not, done.

Click Open Log File to access the log from the summary page of the
wizard; this option is available if the wizard has succeeded or failed.

The wizard creates the resources shown in|Table 1

Table 17. Resources created by the Default Configuration wizard

Name

Type

DEFBKDB6

Broker database

Local_Domain

Broker domain

LocalProject

Server project

WBRK6_DEFAULT_CONFIGURATION_MANAGER | Configuration Manager that manages the

broker domain

WBRK6_DEFAULT_BROKER Broker

WBRK6_DEFAULT_QUEUE_MANAGER WebSphere MQ queue manager that hosts the

broker and Configuration Manager. The queue
manager has a listener at port 2414.

It also starts the Configuration Manager and the broker so that they are
ready to process a sample.

On the final page, ignore the option to start the Samples Preparation
wizard; you will start this wizard later in these instructions.

Click Finish to close the wizard.

When the wizard completes, it opens the broker topology editor in your
workbench. The editor opens in the Broker Administration perspective and

displays the resources that the wizard has created. The Domains and
Navigator panes within the perspective also show the resources.

You can use the configuration created by the Default Configuration wizard for
other purposes, for example running other samples, or creating and deploying
your own message flows. You can also run the wizard to remove all the
default resources. To start the Default Configuration wizard from the Message
Brokers Toolkit, click File > New > Other > Broker Administration - Getting
Started.
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Running the Pager samples

To verify your installation, return to the Getting Started page. If you cannot
see this page in your workbench, click Help > Welcome to return to the
Welcome page, and click the Getting Started icon again.

01010}
1. Click the Run the Pager samples text (Linux) or icon (Windows) M.

The Samples Gallery opens in a separate window and displays the "Pager
samples” page which presents the following options:

* Set up the Pager samples

This option starts the Samples Preparation wizard, which helps you to
import the samples into your workspace, and to deploy the samples and
associated resources (for example, message flows) to the default broker.

* Run the Pager samples

This option opens the help page with a description of each of three
sample programs, and icons that you can click to start each one.

* Find out what the Pager samples do

This option opens a page that describes in detail what the Pager
samples do and how they work. You can examine the message flows
that implement their function and the messages that are handled by
those flows.

2. Click Set up the Pager samples. The Samples Preparation wizard starts
and displays its first page. The option to import and deploy to the default
broker is preselected.

3. Click Next and follow the guidance provided by the wizard to navigate
through its pages.
The wizard displays a progress bar that shows which task it is currently
performing. It also reports on all the actions that it takes by writing
progress information into a scrollable text window. You can copy and
paste some or all of the information in this text window. This information
is also written to the following log file:

install_dir/eclipse/workspace/.metadata/samplePreparationiizard.log

If the wizard encounters an error in processing, it informs you of what has
happened and returns any error information, for example a return code
from a command. If you know why the error has occurred from the error
text, and can correct the situation, you can do so now. Return to the error
message display and click Yes to continue the wizard.

If you do not understand the error, and do not know how to fix it, click
No. The wizard rolls back all the actions that it has taken so far, if it can,
so that when it completes, your system is in the same state as it was in
before you started the wizard. The text window shows you exactly what
the wizard has, and has not, done.
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The wizard displays information messages to show that the Pager samples
and associated resources are deployed and ready to run.

. Click Next when you have read the messages about the actions completed

by the wizard. The confirmation page is displayed.

. Click Finish to close the wizard. The "Pager samples” page (from which

you launched the wizard) is redisplayed.

. Click Run the Pager samples. A help page opens and displays two

sections:
* Running the Text Messenger sample (point-to-point messaging)

The Text Messenger sample briefly introduces you to the point-to-point
style of messaging, and demonstrates how message transformation
works. Click the Pager icon to launch the Pager application; click the
Text Messenger icon to start that application and send messages to the
Pager application.

You can start these applications in either order; because they use
WebSphere MQ to pass messages between applications, messages can be
held safely for an application and can be retrieved by that application
when it starts.

* Running the SurfWatch sample (publish/subscribe messaging)

The SurfWatch sample briefly introduces you to the publish/subscribe
style of messaging, and demonstrates how message transformation
works. Click Surf Report Publisher and Pager to start the publisher
application and the Pager application.

Click Start in the Surf Report Publisher window to start sending
messages about weather conditions at certain surfing locations to the
Pager application. Pager displays all messages that it receives in its
window.

Click Subscriptions. The Surf Report Subscriptions dialog opens. Here
you can select the locations for which you want to receive surf reports;
the messages sent to Pager are controlled by this dialog.

Refer to the help pages to read and understand more about how these
applications work together.

. When you have sent and received messages successfully, you have verified

that your installation is complete. You can now close your Pager
applications.
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You can start the Samples Preparation wizard to create the resources and start
other supplied sample programs. Click File > New > Other > Broker
Administration - Getting Started in the Message Brokers Toolkit and select
Preparing the Samples. The Samples Preparation wizard opens and lists other
samples that are available. You can also access the Samples Gallery from the
information center.

You can also invoke the Samples Preparation wizard to remove the sample or

samples from the broker, and to remove the sample resources from your
workspace.

Chapter 11. Configuring and verifying your system 113



Running the Pager samples

114 Installation Guide



Chapter 12. What’s next

When you have completed installation, there are two main sources of
information that you can use to help you learn about the product, and to
create and deploy a broker domain on all operating systems. Launch the
Message Brokers Toolkit to access these resources:

The Welcome page
The Welcome page is typically what you see when you first launch
the Message Brokers Toolkit. You can also access it at any time; click
Help > Welcome to display this page. Minimize the Welcome page to
view it alongside other open panes in the toolkit; close it when you
no longer want it in view.

The Welcome page has been designed to ensure that both new and
experienced users can find what they need when they have completed
the installation process. It also helps you if you are migrating from
previous versions.

In addition to Getting Started (covered in [Chapter 11, “Configuring|
land verifying your system,” on page 107), the Welcome page displays
these additional choices for you to explore:

* If you are new to WebSphere Message Broker, click the Overview

icon Q to learn about the product.

Access the Quick Tour, which provides new users with an overview
of key product concepts, and shows its main interfaces in a
graphical format. The tour lasts approximately 15 minutes.

* If you have experience of WebSphere Message Broker, click the

What's New icon :; to see what new and enhanced functions
are included in Version 6.0.

* If you have a previous version installed, click the Migrating icon

\;i> to view a description of the steps that you need to take to
migrate your current broker domain to Version 6.0. The information
provided includes planning, preparation, and implementation steps.
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(f@
* Click the Samples icon J to explore samples that show how to
exploit the function of the broker.

The samples are presented in a Samples Gallery, which includes
samples that show how you can develop message flows and
message sets that exploit the message routing and transformation
capabilities of the broker.

¢ Click the Web Resources @ icon to link to additional resources
on the Web that support WebSphere Message Broker. These include
education courses, Business Partners, and IBM support.

The information center

Installation Guide

The information center provides full post-installation documentation
for the product on all operating systems. Click Help > Help Contents
in the Message Brokers Toolkit to open the information center in a
new window. The front page links to topic pages within the
information center and to other resources such as Redbooks. You can
also read about different ways to find information in the information
center, whether you are a new user or an experienced user.

The information center is divided into sections that cover tasks and
reference information. The task sections listed below are typically
those that you might want to explore first.

Configuring the broker domain

The broker domain and its components are explained, and the
tasks that you must complete to create a broker domain and
the resources that it requires on all operating systems are
described.

* Use the appropriate mqsi commands (for example,
mgsicreatebroker). Navigate through the Configuring
section to find details about the tasks involved in creating
your configuration and the commands to use.

When you issue commands on a distributed system, you
must ensure that you issue them in the correct environment
and to the correct installation. For the verification process
described in [Chapter 11, “Configuring and verifying your|
[system,” on page 107,| the Default Configuration wizard
completes this action for you, but you must setup the
environment yourself if you are not using the wizard, or if
you are working on operating systems on which the wizard
is not available.
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Linux and UNIX
Run the mgsiprofile file, supplied in the following
directory:

install_dir/bin

Windows
Click Start > IBM WebSphere Message Brokers 6.0
> Command Console to open a window with the
correct environment set up. Invoke the commands
in this window.

For more information about the Start menu, see
[“Menu updates” on page 125.|

See the topics in the information center under Reference >
Operations > Commands for more details about
mgsiprofile, and how to initialize the environment.

This action is not required on z/OS.

* On Linux (x86 platform) and Windows, use the Default
Configuration wizard to create components of fixed names
on systems local to the toolkit, as explained in[Chapter 11
[“Configuring and verifying your system,” on page 107] You
might find this wizard useful even if you do not want to
complete the verification steps.

¢ On Windows only, use the Command Assistant wizard to
create components with your choice of names and
characteristics. In the Message Brokers Toolkit, click File >
New > Other > Broker Administration - Getting Started to
access the Command Assistant wizard. This wizard can also
modify and delete existing components.

Developing applications

This section provides details about how to develop message
flows, message sets, user-defined extensions,
publish/subscribe applications, and more.

Deploying

Find out about BAR files, configurations, and topology, and
how to deploy the message flows and other resources that
you have developed.
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Appendix A. Installation problems

This appendix describes problem scenarios that you might experience during
component installation on distributed systems. Refer to the Program Directory
for WebSphere Message Broker for z/OS or the Program Directory for WebSphere
Message Broker with Rules and Formatter Extension for z/OS if you experience
problems installing on z/OS.

The installation wizards return zero if installation is successful. If a non-zero
return code is returned, check the installation log files for errors and
explanations:

* For runtime components, the log file mqsi6_install.log is stored in the
home directory associated with your account:

Linux and UNIX
Enter echo $HOME to find your home directory.

Windows Your home directory is typically C:\Documents and
Settings\userid. Enter echo $HOMEPATH% to check the
location.

+ For the Message Broker Toolkit, the log file wnbt_install.log is stored in
the install_dir\logs directory.

Typical problems, with a solution, or a workaround, are described below:

Linux and UNIX: display problems
If you try to install one or more runtime components using the
graphical interface, you might see one of two common errors
reported. These typically occur if you log in remotely, or you switch
user ID.
e Can't open display localhost:1.0
Check that the DISPLAY variable is set to the correct value. If you
are logged in locally, the typical value is :0.0 or Tocalhost:0.0.
e Connection to ":0.0" refused by server
Run the following command, where user is the user you are logged
in as:
xauth merge “user/.Xauthority

If you are unable to correct this error, contact your systems
administrator for further help.
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All operating systems: runtime component installation process is
interrupted

If you are installing runtime components, and the process is
interrupted before completion, for example due to a power failure,
delete the install_dir and all its contents before you restart the
program.

Linux: java.lang.UnsatisfiedLinkError

If you are installing in graphical mode on Linux, there are additional

packages that you must install for this mode to succeed. See [Table 3

for details.

Linux: RPM query fails

If you invoke an RPM (package monitor) query after you have
installed the product, and nothing is returned, it is likely that your
system does not have the required RPM support.

An information message similar to the following message might have
been reported in the installation log:

(01-Jun-2005 09:02:27), mgsi.Setup,
com.ibm.wizard.platform.Tinux.LinuxProductServiceImpl, wrn,
The installer could not successfully add the product information
into the RPM database. Installation will continue as this is not
critical to the installation of the product.

Install the additional RPM build package described in [Table 3 on pagel

Linux and UNIX: insufficient temporary space
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When you install the product, the installation program tries to unpack
product files into the local system’s temporary file space. On Linux
and UNIX systems, the temporary space is typically /tmp. If there is
not enough file space available in this directory, the command might
fail without reason (the command returns with no comment), or it
might report a lack of file space.

To correct this problem, give the installation wizard (for example,
setupaix) a temporary file system to use. The command-line option is
-is:tempdir name of temp directory.

For example, on AIX, enter the following command:
./setupaix -is:tempdir /largetemp

Do not specify a temporary directory that is NFS mounted from
another machine; if you do so, the installation might fail because user
permission checks made by the installer sometimes report an error
that security principals mqm and mqbrkrs do not exist on the local
machine.
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See [Table 2 on page 6| to check how much temporary space is
required.

Linux (x86 platform) and Windows: RPU problems
When you install the Message Broker Toolkit, the installation program
prompts you to upgrade a Rational product, that you have already
uninstalled, to a newer level.

There is a known problem with the Rational installation, which results
in a failure to update an information file that the dependency checker
accesses. If this problem occurs, cancel the installation program, and
select Help > Software Updates > IBM Rational Product Updater to
run the RPU. This action refreshes the information file so that you can
rerun the toolkit installation.

Linux (x86 platform) and Windows: function missing in toolkit
After you have installed the Message Broker Toolkit, some of the
expected function appears to be missing.

Select Help > Software Updates > IBM Rational Product Updater to
run the RPU. If the RPU shows the toolkit to be version 1.0.0, the
installation has not completed successfully. There are two probable
causes for these symptoms:

1. There was insufficient temporary space to complete the
installation. Check the amount of temporary space that is required
in ["Memory and disk space” on page 5)and run the installation
again.

2. There is a problem with the Language Pack feature. Find the log
file run_wmbt_rad_update_errout.log in install_dir\logs and
look for the following message:

Component feature "updater.crystal.nll.plugins.6001" not found

You selected the Language Pack feature when you installed the
Message Broker Toolkit, but existing Rational products have not
included this feature, and therefore required Rational framework
components are missing. Either run the installation again, and
clear the option that installs the Language Pack feature, or
re-install the existing Rational product with the Language Pack
feature. For more information about this feature, see
[Language Pack feature” on page 18

Linux (x86 platform) and Windows: adding the Language Pack feature after
installation
If you choose to add the Language Pack feature after installation, as
described in [“Adding the Language Pack feature after installation” on|
lpage 101 | the following error messages are generated by step 1:

* In the RAD log run_wmbt_rad_update_errout.log:

Component feature "updater.j2c.nll.plugins.601" not found
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* In the J2C log run_wmbt_j2c_update_errout.log:
Component feature "updater.csdev.nll.plugins.601" not found

You can safely ignore these errors and continue with step 2 which
resolves the missing features.

Linux (x86 platform) and Windows: accessing installation images
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When you install the Message Broker Toolkit from copies of the
installation images that you have created on a local or remote drive,
you might see the following message displayed by the installation
wizard:

Errors occurred during the installation.

An error occurred and product installation failed. Look at the log file
log file_location for details.

Check the log for a message similar to the following text:

21-Jan-2005 124:39:03), Install,
com.ibm.rational.cdi.archive.CDIInstallArchive,

err, ProductException: (error code = 601; message="err";
additional data = [b_rwd:java.io.IOException:

Could not obtain resource: Improper test folder structure.])

The installation wizard has failed because it cannot find the images it
requires. Check that you have correctly set up the directory structure
for the image copies, with all disk images in subdirectories within a

single directory. See [“Accessing CDs and DVDs on a remote system’]
for details of the structure required.
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The installation program makes changes to your system; for example, it
updates menus, creates directories, and creates and modifies environment
variables. Details are provided in these sections:

* ["Menu updates’]

s ['Directory structures” on page 126

¢ [‘Registry entries” on page 139

* [‘Environment variables” on page 140

* [‘Default WebSphere MQ resources” on page 141|

Menu updates

If you install the Message Broker Toolkit on SUSE Linux (x86 platform), the
main menu is populated with the following entries:

e IBM WebSphere Message Brokers 6.0 > WebSphere Message Brokers
Toolkit

* IBM WebSphere Message Brokers 6.0 > Readme
* IBM WebSphere Message Brokers 6.0 > Rational Product Updater

If you install the Message Broker Toolkit on Red Hat Linux (x86 platform), the
main menu is populated with the following entries:

¢ Programming > Rational Product Updater

* Programming > Readme

* Programming > WebSphere Message Brokers Toolkit

If you install the Message Broker Toolkit on Windows, the Start menu is
populated with the following entries:

* Programs > IBM WebSphere Message Brokers 6.0 > Rational Product
Updater

* Programs > IBM WebSphere Message Brokers 6.0 > Readme
e Programs > IBM WebSphere Message Brokers 6.0 > Start help
* Programs > IBM WebSphere Message Brokers 6.0 > Stop help

* Programs > IBM WebSphere Message Brokers 6.0 > WebSphere Message
Brokers Toolkit
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If you have installed one or more runtime components on Windows, the Start
menu is populated with the following entries:

Programs > IBM WebSphere Message Brokers 6.0 > Command Console

Programs > IBM WebSphere Message Brokers 6.0 > Java Programming
APIs > Configuration Manager Proxy API Documentation

Programs > IBM WebSphere Message Brokers 6.0 > Java Programming
APIs > Configuration Manager Proxy API Exerciser

Programs > IBM WebSphere Message Brokers 6.0 > Java Programming
APIs > Java Plugin API Documentation

Programs > IBM WebSphere Message Brokers 6.0 > Uninstall > Message
Broker

Directory structures
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When you install WebSphere Message Broker, the installation wizard creates a
structure of subdirectories under the directory that you specify as the
installation directory (install_dir).

If you have performed a custom installation of the runtime components, the
structure depends on the components that you select and might differ from
the structures shown here.
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AIX

Directory structures

On AIX, the default home directory install_dir is /opt/IBM/mqsi/6.0.

Directories are created in two locations, shown in [Table 18| and [Table 19 on|

Table 18. AlX installation directory structure

Directories under install_dir | Contents
_uninst_runtime Uninstall programs
| _uninst_runtime_jvm Uninstall programs (JVM)
bin Executable binaries
catalina Web Services support files
classes Java class files
| DD64 ODBC driver and related files (64-bit support)
docs Java API files
| exmltConfig XML transformation files
include Header and other files for samples
itim Tivoli License Manager files
jplugin Java plug-in files
jre IBM Runtime Environment for the Java Platform
1ib Shared library files
Ticense License files
I 191 Loadable library files (32-bit)
| 11164 Loadable library files (64-bit)
I merant ODBC driver and related files
messages Description files for messages and exceptions
migration Migration files
readmes Product readme files
sample C, C++, and Java sample files
| xml4c XML processing files
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Table 19. AlX working directory structure

Directories under /var/mqsi

Contents

common/errors

Error files

common/Tocks

Resource locks

common/Tog

Trace files

common/profiles

User profiles

components Component details
config Profiles

odbc ODBC files
registry Registry information

shared-classes

User installed user-defined node classes

XML

User XML file resources

XSL

User stylesheet resources
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Directory structures

On HP-UX, the default home directory install_dir is /opt/IBM/mqsi/6.0.

Directories are created in two locations, shown in [Table 20| and [Table 21 on|

Table 20. HP-UX installation directory structure

Directories under install_dir | Contents
_uninst_runtime Uninstall programs
| _uninst_runtime_jvm Uninstall programs (JVM)
bin Executable binaries
catalina Web Services support files
classes Java class files
| DD64 ODBC driver and related files (64-bit support)
docs Java API files
| exmltConfig XML transformation files
include Header and other files for samples
itim Tivoli License Manager files
jplugin Java plug-in files
jre IBM Runtime Environment for the Java Platform
1ib Shared library files
Ticense License files
I 191 Loadable library files (32-bit)
| 11164 Loadable library files (64-bit)
I merant ODBC driver and related files
messages Description files for messages and exceptions
migration Migration files
readmes Product readme files
sample C, C++, and Java sample files
| xml4c XML processing files
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Table 21. HP-UX working directory structure

Directories under /var/mqsi

Contents

common/errors

Error files

common/Tocks

Resource locks

common/Tog

Trace files

common/profiles

User profiles

components Component details
config Profiles

odbc ODBC files
registry Registry information

shared-classes

User installed user-defined node classes

XML

User XML file resources

XSL

User stylesheet resources
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Linux

Directory structures

Runtime components

On Linux (POWER platform), Linux (x86 platform), and Linux (zSeries
platform), the default home directory install_dir for runtime components is
/opt/ibm/mqsi/6.0.

Directories are created in two locations, shown in [Table 22| and [Table 23 on|

Table 22. Linux installation directory structure (runtime components)

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

bin Executable binaries

catalina Web Services support files

classes Java class files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itlm Tivoli License Manager files

jplugin Java plug-in files

jre IBM Runtime Environment for the Java Platform

1ib Shared library files

Ticense License files

111 Loadable library files (32-bit)

merant ODBC driver and related files
(Linux (POWER platform) and
Linux (x86 platform) only)

messages Description files for messages and exceptions

migration Migration files

readmes Product readme files

sample C, C++, and Java sample files

xml4c XML processing files
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Table 23. Linux working directory structure (runtime components)

Directories under /var/mqsi

Contents

common/errors

Error files

common/Tocks

Resource locks

common/Tog

Trace files

common/profiles

User profiles

components Component details
odbc ODBC files
registry Registry information

shared-classes

User installed user-defined node classes

XML

User XML file resources

XSL

User stylesheet resources
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Directory structures

Message Brokers Toolkit

On Linux (x86 platform) only, the default home directory install_dir for the
Message Brokers Toolkit is /opt/ibm/MessageBrokersToolkit/6.0. The default
workspace directory is /IBM/wmbt6.0/workspace in your home directory.

The directories created are shown in [Table 24

Table 24. Linux installation directory structure (Toolkit)

Directories under install_dir

Contents

bin

Rational directories and files

csdev

Rational directories and files

csdevrpt_shared

Rational directories and files

eclipse Toolkit features and plug-ins
evtoolkit Event Broker specific plug-ins
ibtoolkit Message Broker specific plug-ins
Togs Installation logs

rad Rational directories and files

radrsm_shared

Rational directories and files

Resource Adapters

Rational directories and files

runtimes

Rational directories and files

rwd

Rational directories and files

rwdrpt_shared

Rational directories and files

sdpisv Rational directories and files
setup Installation program and file
updater Rational product updater (RPU) files

updater/eclipse RPU executable file for command-line execution

wmbt_prod Readme files, product information

wmbt_prod/_uninst Uninstall files
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Solaris

On Solaris, the default home directory install_dir is /opt/IBM/mqsi/6.0.

Directories are created in two locations, shown in [Table 25| and [Table 26 on|

Table 25. Solaris installation directory structure

Directories under install_dir | Contents
_uninst_runtime Uninstall programs
_uninst_runtime_jvm Uninstall programs (JVM)
bin Executable binaries
catalina Web Services support files
classes Java class files
DD64 ODBC driver and related files (64-bit support)
docs Java API files
exmltConfig XML transformation files
include Header and other files for samples
itim Tivoli License Manager files
jplugin Java plug-in files
jre IBM Runtime Environment for the Java Platform
1ib Shared library files
license License files
I 141 Loadable library files (32-bit)
| 1i164 Loadable library files (64-bit)
I merant ODBC driver and related files
messages Description files for messages and exceptions
migration Migration files
readmes Product readme files
sample C, C++, and Java sample files
xml4c XML processing files
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Table 26. Solaris working directory structure

Directories under /var/mqsi

Contents

common/errors

Error files

common/Tocks

Resource locks

common/Tog

Trace files

common/profiles

User profiles

components Component details
config Profiles

odbc ODBC files
registry Registry information

shared-classes

User installed user-defined node classes

XML

User XML file resources

XSL

User stylesheet resources
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Windows

Runtime components

On Windows, the default home directory install_dir is C:\<Program Files
folder>\IBM\MQSI\6.0. The default working directory work_dir is C:\Documents
and Settings\A11 Users\Application Data\IBM\MQSI. Your system might have
a different value for Documents and Settings\A11 Users\, but the remainder

of this path is fixed.

Directories are created in two locations, shown in [Table 27| and [Table 28 on|

Table 27. Windows installation directory structure (runtime components)

Directories under install_dir | Contents

_uninst_runtime Uninstall programs

_uninst_runtime_jvm Uninstall programs (JVM)

bin Executable files; .exe, .dll, .lil

catalina Web Services support files

classes Java class files

DataDirect ODBC files

docs Java API files

exmltConfig XML transformation files

include Header and other files for samples

itim Tivoli License Manager files

jplugin Java plug-in files

jre IBM Runtime Environment for the Java Platform
1ib Shared library files

license License files

messages Description files for messages and exceptions
migration Migration files

readmes Product readme files

sample C, C++, and Java sample files
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Table 28. Windows working directory structure (runtime components)

Directories under work_dir

Contents

Common\dbinstmgr

Derby database files

Common\errors

Error files

Common\Tocks

Resource locks

Common\1og

Trace files

Common\profiles

User profiles

components

Component details

shared-classes

User installed user-defined node classes

XML

User XML file resources

XSL

User stylesheet resources
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Message Brokers Toolkit

On Windows, the default home directory install_dir for the Message Brokers
Toolkit is C:\Program Files\IBM\MessageBrokersToolkit\6.0. The default
workspace directory is \IBM\wmbt6.0\workspace in your home directory.

The directories created are shown in [Table 29

Table 29. Windows installation directory structure (Toolkit)

Directories under install_dir

Contents

bin

Rational directories and files

csdev

Rational directories and files

csdevrpt_shared

Rational directories and files

eclipse Toolkit features and plug-ins
evtoolkit Event Broker specific plug-ins
ibtoolkit Message Broker specific plug-ins
Togs Installation logs

rad Rational directories and files

radrsm_shared

Rational directories and files

Resource Adapters

Rational directories and files

runtimes

Rational directories and files

rwd

Rational directories and files

rwdrpt_shared

Rational directories and files

sdpisv Rational directories and files
setup Installation programs and files
updater Rational product updater (RPU)

updater\eclipse

RPU executable file for command-line execution

wmbt_prod

Readme files, product information

wmbt_prod\_uninst

Uninstall programs

z/0S

The default installation directory is /usr/1pp/mqsi/VxRxMx where VxRxMx
represents Version X, Release X, Modification X, for example, V6ROMO.

For more details of locations, libraries, and file system paths, see the Program
Directory for WebSphere Message Broker for z/OS or the Program Directory for
WebSphere Message Broker with Rules and Formatter Extension for z/OS.
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Registry entries

Registry entries
When you install WebSphere Message Broker, the installation program creates

a number of entries in a registry. Further changes are made by some
configuration updates (for example, when you create a broker).

Runtime components
On Windows, the system registry is used; on Linux and UNIX systems,
equivalent entries are stored in /var/mgsi/registry. Do not alter or remove
these entries unless instructed to do so by your IBM Service representative.

shows the main Windows registry entries, created under
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\WebSphereMQIntegrator. Corresponding
entries exist on Linux and UNIX systems. The number and content of entries
depends on the components that you have installed and configured.

Table 30. Registry entries for runtime components

Location Description

component_name Top level entry for each component that you
have installed and configured.

component_name\CurrentVersion\FADLevel Formats and Data version; contents depend
on service installed. FADLevel does not
necessarily change with each product update.

component_name\CurrentVersion\QueueManagerName |Name of queue manager for this component.

component_name\CurrentVersion\ DataSourceName Name of database for this component

For the installed database drivers for Oracle and Sybase, entries that contain
driver locations and parameters are created under the following key:

HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI

For Event Log information, an entry is added under the following key:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\Application\BIPv600
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Message Brokers Toolkit

On Windows, the system registry is used; on Linux (x86 platform), equivalent
entries are stored in /etc/IBM/WebSphereMessageBrokersToolkit/. Do not alter
or remove these entries unless instructed to do so by your IBM Service
representative.

able 31| shows the main Windows registry entries, created under
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\WebSphereMessageBrokersToolkit.

Table 31. Registry entries for the Message Brokers Toolkit

Location Description
product\com.ibm.wmbt Installation location and version details
components\com.ibm.wmbt.specific Location of files specific to Message Broker

Environment variables

On distributed systems you must run a profile to initialize environment
variables to create the product environment before you use the product or
configure any resources. Use the profile files provided with WebSphere
Message Broker to initialize the environment. Profiles are associated with a
specific installation, and are located in the following directory:

install_dir/bin

For the verification process described in [Chapter 11, “Configuring and|
[verifying your system,” on page 107/ this requirement is completed by the
Default Configuration wizard, and you do not have to run this profile
yourself.

On Windows, you can use the command console (available through the Start
menu) to set up the required environment. When you start the console, the
profile is invoked and the correct environment is set for you automatically.

On z/0S, the PDS hlq.SBIPSAMP (where hlg is the high-level file system
qualifier) includes the following profiles that provide a similar function:
* BIPBPROF: Broker

* BIPCPROF: Configuration Manager

* BIPUPROF: User Name Server
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Default WebSphere MQ resources

When you create a broker, a Configuration Manager or a User Name Server,
WebSphere MQ resources are created to support their configuration.

The resources created have names that begin with the reserved characters
SYSTEM. lists the resources and indicates the component queue
manager with which they are associated. All the resources are queues with the
exception of SYSTEM.BKR.CONFIG, which is a channel of type SVRCONN.

Table 32. Default WebSphere MQ resources

Resource name

Queue
manager

Description

SYSTEM.BROKER.ADMIN.QUEUE

Broker

Target for messages sent by
the Configuration Manager
and commands to modify
the broker’s configuration
and operation

SYSTEM.BROKER.ADMIN.REPLY

Configuration
Manager

Target for response
messages sent by the broker
to the Configuration
Manager

SYSTEM.BROKER.AGGR.CONTROL

Broker

Used internally for control
messages for aggregation

SYSTEM.BROKER.AGGR.REPLY

Broker

Used internally for known
replies received by the
AggregateReply node

SYSTEM.BROKER.AGGR.REQUEST

Broker

Used internally for requests
that form part of an

aggregate group

SYSTEM.BROKER.AGGR. TIMEOUT

Broker

Target for timeout and
unknown timeout
processing within the
AggregateReply node

SYSTEM.BROKER.AGGR.UNKNOWN

Broker

Target for unknown replies
received by the
AggregateReply node

SYSTEM.BROKER.CLIENTS.DATA

Broker

Used internally for
publish/subscribe data

SYSTEM.BROKER.CONFIG.QUEUE

Configuration
Manager

Target for messages sent to
the Configuration Manager
from the Message Brokers
Toolkit
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Table 32. Default WebSphere MQ resources (continued)

Resource name Queue Description
manager
SYSTEM.BROKER.CONFIG.REPLY Configuration | Target for messages sent to
Manager the Message Brokers Toolkit
by the Configuration
Manager
SYSTEM.BROKER.CONTROL.QUEUE Broker Target for
publish/subscribe control
requests sent to the broker
by applications
SYSTEM.BROKER.EXECUTIONGROUP.QUEUE Broker Target for messages sent by
the Configuration Manager
to the broker
SYSTEM.BROKER.EXECUTIONGROUP.REPLY Broker Target for response
messages from the User
Name Server to the broker
SYSTEM.BROKER.INTER.BROKER.COMMUNICATIONS | Broker Target for
publish/subscribe control
messages
SYSTEM.BROKER.INTERBROKER.MODEL.QUEUE Broker Model for dynamic
publication queues
SYSTEM.BROKER.INTERBROKER.QUEUE Broker Target for
publish/subscribe messages
sent by neighbor brokers
SYSTEM.BROKER.IPC.QUEUE Broker Target for internal control
messages
SYSTEM.BROKER.MODEL.QUEUE All Model for dynamic

response queues

SYSTEM.BROKER.SECURITY.QUEUE

User Name

Target for messages to the

Manager and
broker

Server User Name Server from the
Configuration Manager,
brokers, and the Message
Brokers Toolkit
SYSTEM.BROKER.SECURITY.REPLY Configuration | Target for response

messages from the User
Name Server to its

requestor
SYSTEM.BROKER.SUBSCRIPTIONS.DATA Broker Used internally for

publish/subscribe data
SYSTEM.BROKER.TIMEOUT.QUEUE Broker Target for timeout message

stored by the
TimeoutControl node
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Table 32. Default WebSphere MQ resources (continued)

WebSphere MQ resources

Resource name Queue Description
manager
SYSTEM.BROKER.WS.ACK Broker Used internally for Web
Services client support
SYSTEM.BROKER.WS.INPUT Broker Used internally for Web
Services client support
SYSTEM.BROKER.WS.REPLY Broker Used internally for Web
Services client support
SYSTEM.BKR.CONFIG Configuration |Connection channel for
Manager Message Brokers Toolkit
clients

These resources are defined in addition to the default WebSphere MQ objects
that are created when that product is installed.
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Appendix C. Notices

This information was developed for products and services offered in the
United States. IBM may not offer the products, services, or features discussed
in this information in other countries. Consult your local IBM representative
for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state
or imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY,
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore
this statement may not apply to you.
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Notices

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
be incorporated in new editions of the information. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,

Hursley Park,

Winchester,

Hampshire,

England

SO21 2JN.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Programming License Agreement, or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.
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Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

AIX Cloudscape DB2

DB2 Connect DB2 Universal Database e(logo)server
Everyplace IBM IBMLink
IMS Informix iSeries
0S/400 POWER pSeries
RACF Rational Redbooks
RS/6000 SupportPac Tivoli
WebSphere xSeries z/0S

zSeries

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc.
in the United States, other countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

Intel and Pentium are trademarks or registered trademarks of Intel
Corporation or its subsidiaries in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and
other countries.

Linux is a trademark of Linus Torvalds in the United States, other countries,
or both.

Other company, product, or service names may be trademarks or service
marks of others.
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Glossary of terms and abbreviations

This glossary defines WebSphere Message
Broker terms and abbreviations used in this
book. A full product glossary is provided in
the information center. For information
about how to access the information center,
see [“Where to find more information” on|

|Eage xii.|

For information about terms and
abbreviations that are not specific to this
product, see the [[BM Terminology Web site]

B

broker. A set of execution processes that host
one or more message flows. Also known as
message broker.

broker domain. A collection of brokers that
share a common configuration, together with the
Configuration Manager that controls them.

C

collective. A set of brokers that are fully
interconnected and form part of a multi-broker
network for publish/subscribe applications.

Configuration Manager. The component that
provides an interface between the Message
Brokers Toolkit and a set of runtime brokers. It
provides brokers with their initial configuration,
and updates them with any subsequent changes.
It maintains the broker domain configuration.

D

deploy. To make operational the configuration
and topology of the broker domain.

Derby. Derby refers to IBM Cloudscape Version
10.0, a database product that is built on the
Derby database from the Apache Software

© Copyright IBM Corp. 2005,2006

Foundation. Cloudscape does not modify Derby
in any way, but provides additional function
including installers. Derby database support is
embedded in the broker component on Windows
only.

E

execution group. A named process or set of
processes within a broker in which message
flows are executed. The broker is guaranteed to
enforce some degree of isolation between
message flows in distinct execution groups
because it ensures that they execute in separate
address spaces, or as unique processes.

L

local error log. A generic term that refers to the
logs to which WebSphere Message Broker writes
records on the local system. Also known as
system log.

M

message broker. See broker.

Message Brokers Toolkit. The development
environment that integrates with IBM Rational
Application Developer which is based on the
IBM WebSphere Eclipse Platform.

message flow. A sequence of processing steps
that execute in the broker when an input
message is received. A message flow must
include an input node that provides the source of
the messages that are processed. Message flows
are deployed to a broker for execution.

MRM domain. The domain associated with
messages that are modeled in the Message
Brokers Toolkit.
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P

point-to-point. A style of messaging application
in which the sending application knows the
destination of the message. Contrast with
publish/subscribe.

principal. An individual user ID (for example, a
login ID) or a group. A group can contain
individual user IDs and other groups, to the
level of nesting supported by the underlying
facility.

publish/subscribe. A style of messaging
application in which the providers of information
(publishers) are de-coupled from the consumers
of that information (subscribers) using a broker.
See also topic. Contrast with point-to-point
messaging.

publisher. An application that makes
information about a specified topic available to a
broker in a publish/subscribe system.

R

Rational Application Developer (RAD). A
comprehensive integrated development
environment, based on the Eclipse open source
platform, that accelerates application
development and deployment. The Message
Brokers Toolkit is based on RAD.

Rational Product Updater (RPU). A component
of all Rational software products that connects to
an IBM update server on the Web that provides
update (service) packages for those software
products.

S

subscriber. An application that requests
information about a specified topic from a
publish/subscribe broker.

system log. See local error log.
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T

topic. A character string that describes the
nature of the data that is published in a
publish/subscribe system.

topology. The brokers and collectives (and
connections between them) in the broker domain.

Transformation Services. Message
transformation and routing services that extend
the capability of the broker.

U

User Name Server. A component that interfaces
with operating system facilities to determine
valid users and groups.

w

workbench. An active instance of the Message
Brokers Toolkit that is associated with a user’s
workspace. The workbench might also include
plug-ins from other products that have been
integrated with the base plug-ins of WebSphere
Message Broker.

workspace. A store of resources accessed by the
Message Brokers Toolkit, typically associated
with a user or set of users.
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Sending your comments to IBM

If you especially like or dislike anything about this book, please use one of
the methods listed below to send your comments to IBM.

Feel free to comment on what you regard as specific errors or omissions, and
on the accuracy, organization, subject matter, or completeness of this book.

Please limit your comments to the information in this book and the way in
which the information is presented.

To make comments about the functions of IBM products or systems, talk to
your IBM representative or to your IBM authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use
or distribute your comments in any way it believes appropriate, without
incurring any obligation to you.

You can send your comments to IBM in any of the following ways:
* By mail, to this address:

User Technologies Department (MP(095)

IBM United Kingdom Laboratories

Hursley Park

WINCHESTER,

Hampshire

SO21 2JN

United Kingdom

* By fax:
— From outside the U.K,, after your international access code use
44-1962-816151
— From within the U.K., use 01962-816151
* Electronically, use the appropriate network ID:
— IBM Mail Exchange: GBIBM2Q9 at IBMMAIL
- IBMLink"": HURSLEY(IDRCF)
— Internet: idrcf@hursley.ibm.com

Whichever method you use, ensure that you include:

* The publication title and order number

* The topic to which your comment applies

* Your name and address/telephone number/fax number/network ID.
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